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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

i %

ata

M oy |
Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim and adjust the angle of an image
Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

oS Windows 8, Windows 7*1, Windows Vista*2
Windows XP Professional/Home Edition*3
PC with one of the above OS preinstalled

ConpLiEr | Upgraded machines not supported

CPU 1.3GHz Pentium or higher*4

RAM Minimum 1GB*>

Bieda Screen resolution: 1024 x 768 pixels or more

play Color quality : Medium (16 bit) or more
*1

*2

*3

Compatible with 32-bit/64-bit systems for all versions except Starter Edition
Compatible with 32-bit/64-bit systems for Service Pack 2 except
Starter Edition

Compatible with Service Pack 3

*4 Core2 Duo or higher is recommended

*5

For Windows 8 or Windows 7 64-bit systems, minimum 2GB

Check the Canon Web site for the latest system requirements, including
supported OS versions.

Supported Images

This software supports the following image types.

Image type Extension
RAW images*! shot with EOS DIGITAL cameras, .CR2
RAW images | excluding EOS DCS1 and EOS DCS3 TIF
RAW images*2 shot with PowerShot cameras .CRW
- Exif 2.2, 2.21 or 2.3-compatible JPEG
JPEG images images JPG, JPEG
TIFF images | Exif-compatible TIFF images TIF, .TIFF

*1

*2

Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon Web site.

* Only models where Digital Photo Professional is listed in the “Data Type”

item in the “Specifications” section near the end of the Camera User Guide.

* Use the dedicated CameraWindow application to download images from a
PowerShot camera to a computer. See the Software Starter Guide for details.

* Lens aberration correction can only be used with some camera and lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.

* RAW images shot with the PowerShot Prol are also supported, but
they cannot be edited with the DPP RAW image adjustment function.
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Contents at a Glance (i) k! < EE

Introduction

Downloading Images to Your Computer Adijust brightness of shadows/highlights - p.57
Download images by connecting your cameraand 0.7 Reduce image noise = p.62 Contents at
computer ' Correct lens aberration -» p.63 a Glance
Download images using a card reader 2p9 Use the Digital Lens Optimizer - p.69
— : Use a Picture Style file - p.59 o Bearlzit(i:on
Viewing and Checking RAW Images Edit efficiently -p34 P
Quickly enlarge parts of an image 2 p.ll Edit an image while comparing the image before and .-
Sort images (check marks, rating) -» p.18, p.19 after adjustment - Advanced
Display an image _shot simultar_]eous_ly as a RAW >p22 Synchronize multiple images = p.54 Operation
image and JPEG image as a single image Display an area beyond the setrange as awarning -
Display the images in the thumbnail list display at high indicator (Highlight/Shadow warning) - Advanced
resolution = p.23 . . . " . Image Editing
Restore an adjusted image to its condition at the time - p.43 and Printing
Check shooting information such as the shooting date =» p.10, p.23 of shooting - —
N . . Composite images -»p.78 Processing
Editing RAW Images (Adjusting) Create HDR (High Dynamic Range) images - p.82 Laggeir'r\]lgr;gsers
Adjust brightness/darkness = p.12, p.26 - —
Use automatic adjustment = p.33 Printing Editing
Change the Picture Style -»p.26 el c - - .43, p.88, JPEG/TIEE
Sharpen the modulation and contrast of colors (contrast) ~ =» p.29 fint well on a L.anon printer p.89, p.90 Images
Make skin tone look healthier (color tone) = p.30 Faithfully reproduce the color of the subject = p.43, p.88,
Make the image colors more vivid (color saturation)  =» p.30 when printing p-89, p.90 Reference
Adjust an image to make color tone more natural - p.28 Print a thumbnail list of images - p.87
(white balance) ' Approximate the color seen on screen with your 0.94 e
Change an image to black-and-white or sepia tones ;.o printing results '
(monochrome) P —
Trim an image and adjust the angle of an image - p.38 Conversion of Images
Specify an aspect ratio that matches the size of the 38 Convert a RAW image to a JPEG image = p.42, p.101 @ @
paper on which an image is to be printed P Edit in Photoshop - p.78, p.102
Erase dust shot with the image =»p.73, p.75 Perform batch processing - p.101 @
Erase unwanted parts of an image = p.77 Edit (adjust) a JPEG image - p.105

Auto correct RAW images with the Auto Lighting Optimizer =» p.61



1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Double-click the desktop icon.

Double-click

EDS Utility

DPP starts up and the main window ([Folder] window) appears.

v

Main window ([Folder] window)

High quslty Becpe data: Puber of mages: 0

Hmber of seleciod mages- B

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.
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Downloading Images to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.

For downloading images, start up the camera software “EOS Utility”

from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the

main window.

When creating a folder, see p.50.

Select all

Bl Desktop
- Libraries

, sample Pictures

QE Videos

Start up EOS Utility.

Select the [Tools] menu » [Start EOS Utility].

s Window Help

Clear all

Chedk mark

Rotate left Rotate right

Tools

Start Quick check tool Alt+Q
Start Trimming/Angle Adjustment tool Alt+C
Start Stamp tool Alt+5
Start Rename tool Alt+R

[ startEOS Utility Alt+0
Sync folder with EQS Utility
Transfer to Photoshop Alt+P
Preferences... Ctrl+K

EOS Utility starts up.

EOS Utility (Displayed items differ depending on connected

camera)

I, EOS Utility

Control Camera

Accessories

Preferances...

Connect your camera and computer and turn the

camera on.

Connect the camera and your computer with the interface cable

provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF

electronic manual).

The capture window for EOS Utility appears.
When an EOS M is connected, the capture window does not
appear. Proceed to step 5 on the next page.
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Click the [Main Window] button.
IR =2

-I\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

R

Introduction

—_—

Contents at

a Glance
|§| You cannot start up EOS Utility in the [Collection] window ]
ic
am = 100 (p.6, p.36). OpBe1tion
E om B0 When EOS Utility has been started up from DPP, you cannot use
Rt sl the following functions.
From 5 |17 % | * Quick check window view (p.16) Advanced
» Trimming and adjusting the angle of an image (p.38, p.113) Operation
e « Digital Lens Optimizer (p.69)
-Composﬂmg lmages (p-78) . . Advanced
- + Creating HDR (High Dynamic Range) images (p.82) Image Editing
« Dust erasure processing (copy stamp function) and Printing
Live View shoot. ... . (p73 to p77, p116 to p120)
e « Batch change file names (rename function) (p.103) Processing
| « Printing with shooting information (p.86) La{)%elrlr\]lggngsers
S 3 « Printing a thumbnail list (contact sheet printing) (p.87) S
The main window for EOS Utility appears. « Printing using Easy-PhotoPrint EX or Easy-PhotoPrint Editing
Download images. (Plug-in prlnt!ng) (p.43, p.46) JPEG/TIEE
__ « Transferring images to Photoshop (p.78) Images
E‘ "‘—T ‘: « Batch saving images (batch processing) (p.101) —
Reference
@ Starts to download images CIICk
“_& Lets you select and download images
Camera settings/Remote shooting IndeX

e

Downloading of images begins.

The downloaded images are saved in the folder selected in step @
1 and are displayed in the main window of DPP. ~—
The downloaded images are sorted by date into folders and

saved.



Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open [My Computer] » [EOS_DIGITAL] and drag the
[DCIM] folder to the [Desktop].

ustment  Tools Window Help

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

B3 Floppy Disk Drive (&)
iy Local Disk (C:)
B3 DVD RW Drive (D)
-y Windows7_0S (E9)
b EOS_DIGITAL (F2)
-y DCIM
- Network

fe . 102CANON

=)

»Images in the folder are displayed in the main window of DPP.

Y
~

@< Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

|§| Copying to your computer may take time when there is a large
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).

R

Introduction

—_—

Contents at
a Glance

|

ic
Open@tion

Advanced
Operation

Advanced
Image Editing

and Printing
—_—

Processing
Large Numbers

of Images
N ——

Editing
JPEG/TIFF

Images
—_—

Reference

—_—

Index

[

Q0
)

—



Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

Viewing Images as Thumbnails in the Main Window

) ] Rotate selected image
Main window

e
. —
sl
s

e

G A 5D i sy [ Pt o mages: 13

Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP.
If the message [Insufficient memory.] appears, there are too
many images in one folder. Decrease the number of images in
one folder such as by dividing them into smaller folders.

|§| When aspect ratio information is attached to the shot image with
the EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark lIl,
EOS-1D Mark lll, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 70D,
EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D or EOS M, the image is
displayed as a trimmed image (p.38, p.113).
For a list of main window functions, see p.126.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

Edit in Edit image window

View collections

Tool palette
Tab

Folder view
Toolbar
Rating

Ctrl+Right Arrow
Alt+G

Ctrl+T

Ctrl+0

Large thumbnail
Medium thumbnail
Small thurnbnail

Thumbnail with infermation

Crl+1
Cirl+2
Ctrl+3
Ctrl+4

Sort

»

=» The display changes to the selected item.

R

Introduction

—_—

Contents at
a Glance

|

ic
Open@tion

Advanced
Operation

Advanced
Image Editing

and Printing
—_—

Processing
Large Numbers

of Images
N ——

Editing
JPEG/TIFF

Images
—_—

Reference

—_—

Index

[



Enlarging and Viewing an Image in the Edit Window

Double-click

The edit window appears.

Edit window

tervona Lo AN

Tool palette
(s S—

s aca | o | ume

[T = |I

]
e =

e =

(MISE000 1 2, 44,28 S dckbe R CWYK Figh pusity

It may take time for the image to redraw itself.
Click the [&]] in the upper right of the edit window to close the
edit window.

|§| By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size
has been changed and then been converted and saved (p.42, p.136),
images for which you selected an effect other than [Shot settings] as
correction of fisheye lens distortion aberration, or images which have
had settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.129.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

s T —— T

e 000 bt it Jointimt i

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

©® Double-click again to revert to the full view.

» To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

=Q< To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.92).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
RAW |Re8 | nR/ALO [ LENS | )
|Brightness adjustment U?] Rever_ts_ the Ima_'ge to
oo the original settings
l White balance adjustment =] | [_)rag the slider left or
1 % 3 Register... rlght
I@ (Auto) - | Tune...
|Picture Style =]
I@ (Standard) - | Browse...
-10.0 -8.0 6.0 -40 -20 0.0 20 40
Contrast:{0) I
Highlight:(0) [}
Shadow:{0) [}
[ Linear
Color tone:(0) [}
Color saturation: (0) }
[Unsharp mask VI
Strength:(0) I
Fineness:({0) ]
Threshald:(0) I

The image brightness changes in real time according to the
amount of adjustments.

"2 Thetool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette are saved to an image as data
called a “Recipe” (p.98).

@ For a list of tool palette functions, see p.130.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

File
[ Save Ctrl+5 ]
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+5hift+P
Plug-in printing r
Info Ctrl+1
Close Ctrl+W

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method, see
Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.101)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

File
Save Ctrl+5
Save As.. Ctrl+Shift+5
Convert and save... Ctrl+D

Print... Ctrl+P
( )

Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+5Shift+P
Plug-in printing 2
Info Ctrl+1
Close Ctrl+W

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
see Chapter 2 onwards.

Print one image (p.49)

Print with a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.88)

Print with shooting information (p.86)

Printing a thumbnail list (contact sheet printing) (p.87)

Exiting DPP

In the main window, select the [File] menu » [EXit].

File
Open in Edit window Ctrl+ 0
Open in Edit window (enlarged)
Save Ctrl+S
Save As... Ctrl+Shift+5
Add thumbnail te image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remowve from collection Ctrl+5Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+F4

DPP exits.

|§| A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to

all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........ccccccoeeeeeee. 16
SOortiNg IMAgES......oeeiiii e 18
Attaching Check Marks........cccoooeeiiiiiiiii. 18
Setting Ratings ..., 18
Sorting Images in the Main Window .......................... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window...................... 20
Arranging by TYPe ...coovvviiiiiiie e 20
Arranging Freely ..o 21
Displaying a RAW Image and JPEG Image as a Single
[ gT= T =T 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information...............cc.ooooeel. 23
Editing an Image ........ccoooovvieiiiie e 25
About the RAW Tool Palette.........cccooeeveeiiiiieiinnennnnn. 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightn@ss.............uvviiiviviiiiiiiiieeans 26
Changing a Picture Style ............cccooeeeeiii 26
Picture Style File.......cccooiiiiiiiiii 27
Adjusting Color Tone by Changing White Balance.... 28
Adjusting Color Tone Using Click White Balance....... 28
Adjusting Contrast ... 29
Changing Color Tone and Color Saturation............... 30
Adjusting MoONOChrome...............eevveviivviiieniiniiinnnnns 30
Adjusting Image Sharpness.........cccccceeeeviiiiieeiiiinnnnn. 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISE) coiiiiiiiiiiie e 33

Editing Efficiently ... 34
Editing in the Edit Image Window..............ccccvvveeenn... 34
Changing the Thumbnail Display Position to Horizontal .............. 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results............cccccoevieiiviiiie e, 41
Saving Editing Contents to a RAW Image.................. 41
Saving as a JPEG or TIFF Image.........cccccvvvvvvivvnnnnnns 42

Re-Editing an Image........ccccceevvevveiiiiie e 43

Printing an IMage ..........ccovviiiiieeieeie e 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX .............ccceeeees 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint............cccccoeeevennnnn.n. 46
Printing Photographs with a Printer other than Canon
INKJEt PriNtErS.....ccciieeeicee e 49

Organizing IMages .......ccceeveeeeieiiiie e 49
Deleting an Unwanted Image ...........ccccevvvvviiieeeeeeennns 49
Creating a Folder for Saving Images...............ccceeee. 50
MOVING IMAJES ... 50
Moving Images in Folders ............cccconnee, 51
Registering Frequent-Use Folders (Bookmark
RegIStration) .......couvuuiiiiie e 51

Organizing Bookmarks ..........cccccvvvviiiiieeeeeeeiiinn. 51
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort

Introduction

—_—

Double-click the area you want to enlarge.

images into five groups.

Display the quick check window.
Click the [Quick check] button.

I

T Rotate right Quick Stamp Trimming
check 2

Rating « » & & =

pir—

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.

Quick check window

All the images displayed in the main window can be checked in
the quick check window.

o=l | Double-click

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.

@ Double-click again to revert to the full view.

® To exit, click the [OK] button.

|§| When [AF Point] is checkmarked, you can display the AF points

selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size changed
and then been converted and saved (p.42, p.136), which have had
settings specified during RAW processing on the camera for distortion
correction and chromatic aberration correction, which are composited, or
which are created as HDR (High Dynamic Range) images.
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Vs

> Convenient functions of the quick check window

~
-

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.

|§| The enlargement ratio when an image is enlarged is half (50%)
of the 100% (actual pixel size).
You can change the enlargement ratio to 100%, when an image
is enlarged (p.92).
For a list of quick check window functions, see p.134.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ # ] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[1]] to [[E].

Chedk mark:

Clear

Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings
Display the image you want to rate, and then click
any one of the [ «].

Rating

(s = & 3 8)

— Click (changes to [ ] after
clicking [« ])

The rating is set and an icon corresponding to the selected [ ]
appears in the upper left of the window.

(Window shown with a rating of three [ #])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon
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To cancel the rating, click the same [ ] as when the setting was
made on the right of the window.

® As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.

|§| You can also set ratings (including [Reject] setting) from the menu
that appears by right-clicking with the mouse on an image in the
main window.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E4] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [»v] to [«] in the toolbar.

220> ® 9 @& @

Select all Clear all Rotate left Rotste right Quick Stamp Trimming Batch
check Angle proces|

Click

—— Select

frame.

Check mark

@ IMG_000LCRD E@  MGowacR? K lem MG oooscRn

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [@] in the toolbar.

Click (changes to [E1] after clicking [HE])

(e & ) (7

Li Select
B wonce |88 Wewmsos |  cowicu

-» The rating is set and an icon corresponding to the selected [E1]
appears in the image frame.
(Window shown with a rating of three [E4] as an example)

N

Rotate left  Rotate right

- —— Rating icon

@3 MG 0004.CR2

@9 MeozcR: 4 | MG D00A.CR:

To cancel the rating, click the same [E3] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

i@i— To display more thumbnails in the main window

You can display a large number of images by setting the size of thumbnail
images to small (p.10). Then, by selecting the [View] menu » [Rating] and
removing check marks so that ratings no longer appear in the image
frame, you can display still more thumbnail images in the main window.

5

The [Label] menu can also be used to attach check marks and set

ratings.

By selecting the [Edit] menu » [Check mark] or [Rating] » image

selection criteria, you can refine criteria for selecting

checkmarked or rated images.

You can display and change the rating settings set in DPP with

other bundled software and on an EOS-1D X, EOS-1D C, EOS

5D Mark Ill, EOS 6D, EOS 7D (firmware version 2.0.0 or later),

EOS 70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/

100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS

REBEL T3/1100D, or EOS M camera.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

* On an EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS
7D (firmware version 2.0.0 or later), EOS 70D, EOS 60D, EOS
REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D, EOS REBEL T3/1100D, or EOS
M camera:

Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating

settings set for still images on an EOS-1D X, EOS-1D C, EOS 5D

Mark Ill, EOS 6D, EOS 7D (firmware version 2.0.0 or later), EOS

70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D,

EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T3/

1100D, or EOS M camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu P [Sort] » desired item.

Edit in Edit image window Ctrl+Right Arrow

View collections Alt+G
Tool palette Ctrl+T
Tab

Folder view

Toolbar

Rating Ctrl+0

Large thumbnail Ctrl+1
Mediurn thumbnail Ctrl+2
Small thumbnail Ctrl+3

Thumbnail with information Ctrl+4

Sort H Rating: Descending order

Rating: Ascending order

File name

Shooting Date/Time
RAW priority

Check markl

Check mark2

Check mark3

Check mark4

Check mark5

The images are arranged in the order according to the selected
item.
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Sort item Description
Rating: ascending Sorted in order of fewest [ # ].
order
Rating: descending Sorted in order of most [ 4 ].
order
File name Images are sorted by file name in alphanumeric

order (0to 9 = Ato 2).

Shooting Date/Time Images are sorted by shooting date and time

from the earliest.

RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.

Check mark1 -
Check mark5

Images with check marks take priority and are
sorted in number order.

-Z\@/E Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as
follows:

Check markl selected: 1-2->3->4-5

Check mark2 selected: 2—»3—-4->5->1

Check mark3 selected: 3-4->5-»>1->2

Check mark4 selected: 4»5->1-2->3

Check mark5 selected: 5»>1-2->3-4

Arranging Freely
Drag and drop the image to the desired location.

e r e r—

yrvearey i . e e p— e o

=» The image moves to the desired location.

» You can also select multiple images (p.20) and move them.

© The order of rearranged images is maintained until you exit DPP
or select another folder in the folder area.

© Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

E@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.92).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.103).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Tools] menu P [Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences

| General settings | | View settings | Tool palette | color management |

Grid pitch

64 Pixels(8-256)

Image selection status

Images opened in Edit window remain selected in main window

Magnification in Edit window

@) Fit to window ) 50% _)100% 1 200%

Magnification when the Edit/Edit image window is double-clicked

) 50% @ 100% ©)200%

RAW and JPEG

[ [CIDisplay only CR2 mages for CR2 and JPEG files of the same name: )

Sort order in main window

[ Retain sort order

Highlightfshadow Alert
Highlight 255 (192-255) -
Shadow 1} (0-64) -

Quick check tool display

@ 50% ~) 100% {moiré reduction off)

el

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [XXD] mark (p.128).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-Z\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

» Moving or copying an image (p.50)

» Checkmarking (p.18, p.19)

» Rating (p.18, p.19)

» Rotating an image (p.126, p.134, p.135)

« Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[XXD] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.127).

|§| In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)

Save Ctrl+5
Save As.., Ctrl+Shift+5

( Add thumbnail to image and save Ctrl+Shift+T ]
Convert and save... Ctrl+D)
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5hift+G

Clear collection

Delete Del

E@E The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

|§| A large number of images may take some time to add.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.

igital Photo Professional - [E\Users\CANON\P;

Eile Edit Miew Bookmark Label Adjustment Tools

PTiiL Info Selectal  Clearall

Folder

Bl Desktop
f'.rd Libraries
. @/ Docurments

The image information window appears (p.24).
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Select a tab sheet and check information.
[Shooting Information] tab sheet

| Shooting Information | Metadata |

[Metadata] tab sheet

IMG_0001.CR2 o

Shooting Information | Metadata

Item

File Name

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw( Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
150 Speed

Auto IS0 Speed
Lens

Value

IMG_0001.CR2

Canon EQS XXX

Firmware Version Xxx
WAL A VR R R

Shutter-Priority AE
11600

8.0

Evaluative Metering

a

400

OFF

EF70-200mm ff4L USM

m,

Focal Length 183.0mm
Image Size o O
Image Quality RAW

Flash Off

FE lock OFF

White Balance Mode Auto

AF Mode Manual focusing
Picture Style Landscape
Sharpness 4

Contrast a

Saturation ]

Color tone ]

Color Space sRGB

Long exposure noise reduc...  0:0ff

High IS0 speed noise redu... 0:Standard
Highlight tone priority 0:Disable

Auto Lighting Optimizer F:Disable
Peripheral ilumination corr... Disable

Dust Delete Data No

File Size FOHKR 2

IDEscripﬁun

7

[Document Title]
KRN

[Authar]
O

[Authar Title]
OOOGE

[Description]
AN

[Description Writer]
AN

[Keywords]
HHXKHHHK

[Copyright Status]
OO

[Copyright Notice]
OOOGE

[Copyrightinfo URL]
N

-

~ -
- ~

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image after
shooting is displayed in the [Metadata] tab sheet.

IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

IPTC* information can only be appended to JPEG/TIFF images
using Photoshop (CS3 or later).

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

A/

Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window Tool palette

— [Tt

fde Lot Yew Lsbel Jduatmest [row fedes el RAA acm | WAAD | e
[r—pe— =]

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
See p.129 for a list of edit window functions, and p.130 for a list of
tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/ALO] and [LENS] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool Palette] button (p.126) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

RAW |RGB | NR/ALO | LENS | Reverts the image to

| Brightness adjustment ((= Jjit—the original settings
| L 0.00 Enter a numerical value
||White balance adjustment| E”

|i/ 1 2 3 Register...

|ﬂ (Auto) - | Tune...

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochromel].

Picture Style = Reverts the image to
@ (standard) [ sromwse... the original settings

Select

i\

-10.0 8.0 -60 -40 -2.0 00 2.0 4.0
Contrast: (0} 1

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.93).
[Auto] is only applied to images shot with the EOS-1D X, EOS-1D
C, EOS 5D Mark Ill, EOS 6D, EOS 70D, EOS REBEL T5i/700D,
EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS REBEL
T3i/600D or EOS M.
When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS-1D X, EOS-1D C,
EOS 5D Mark Ill, EOS 6D, EOS 70D, EOS REBEL T5i/700D, EOS
REBEL SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D
or EOS M are included. However, [Auto] is actually applied only to
images shot with the EOS-1D X, EOS-1D C, EOS 5D Mark llI,
EOS 6D, EOS 70D, EOS REBEL T5i/700D, EOS REBEL SL1/
100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D or EOS M.
You cannot select [Auto] with multiple-exposure RAW images
created on the camera.
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Picture Style

@)

Standard

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

Description

The Picture Style set on the camera when the
image was shot.

When a mode in the Creative Zone is selected on
the camera, the Picture Style setin () is
displayed.

When a mode in the Basic Zone is selected on
the camera, [Shot settings] is displayed in (), and
image characteristics that are according to the
selected shooting mode are applied.

The image looks vivid.

Ordinarily, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.

The colors will look vivid. Especially the colors of
blue skies, greenery, and sunsets will be vivid in a
shot of nature, outdoor, or sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.30).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Picture Style

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in[].

Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.59
for how to use Picture Style files.
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Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

RAW |RgB | mR/ALO | LENS |
| Brightness adjustment [?”
I 0.00
|White balance adjustment (=N Reverts the image to
(2] B E Register... the original settings
[ﬁ (Auto) - ][ Ture...
' Select

& () is the white balance set on the camera when the image

was shot.

« When a mode in the Creative Zone is selected on the camera,
the white balance set in () is displayed.

* When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

« If you have corrected white balance, the correction value is
displayed in ().

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (this page).

=@= Tune with color tone
To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.30) to get closer to your requirements.

® You cannot register the adjustment results as personal white
balance (p.100) when you have selected [ @& ()] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

RAW |RGB | nR/ALO | LENS |
| Brightness adjustment [?”
I 0.00
White balance adjustment a” .
1 2 3 Register... C“Ck
@ (auto) -] Tune...

Click on a point that is to be the standard for white.
(@ = - | [ S—

[ 1 198 Yew Lsbel papuzmene ook _imdow_tiep Gn [na | wmc e

Reverts the
image to the
original settings

The coordinates of the cursor position and
the RGB values (8-bit conversion)
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The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[# ]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

R
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast

Contents at

a Glance
weaker.
|Picture Style (= Reverts the image to Basic
(@ (standara) +| eromse... | the original settings Operation
L B o Advanced
100 80 60 -40 -20 0.0 20 4.0 Image Editing
Contrast:(0}——— @ Drag the slider left or and Printing
Highlight: (0) 0 right (9 steps)
shadow:(0) 1 Processing
[T Linear Large Numbers
Color tone: (0) 1 of Images
Color saturation:{0) {1
|Unsharp mask v Editing
1 Strength:(0) N} JPEG/TIFF
Fineness:{0) [ Images
Threshold: (0) I}
Displays the value of the setting Befranes
Index

:@3 [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing @ @
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim. @

@ The Auto Lighting Optimizer (p.61) will not function when [Linear] is

checkmarked.
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Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

| Picture Style ( I

Reverts the image to

the original settings

@ (standard)

v] Browse...

-10.0 8.0 -6.0 -4.0 -2.0

Contrast:(0)
Highlight: {0}
Shadow: ()

|:| Linear

Color tone:(0)
Color saturation: (0)——

0.0 20 0

4,
{
I
{
[}

B

Drag the sliders left or
right

lUnsharp mask

7

Strength:(0)
Fineness: (0]
Threshold: (0)

i}
I}
i}

Displays the values of the settings

Color tone:

Color saturation:

Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).

Adjusting

Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

|Picture Style (=] Reverts the image to
[ Monochrome v][M the Original Settings
L i
I |
I ). | LN e
-10.0 80 S0 40 -20 00 20 40
Contrast:(0) D
Highlight:(0) [
Shadow: (0) D I
F”EreﬁecEN::::r | Drag the sliders left or
Toning effect: (Mone) [t rlght
[Unsharp mask v]
Strength:(0) I
Fineness:{0) D
Threshold: (0) I}

Displays the values of the settings
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Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red ;
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Y
~ -

2> Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.

Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].
[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

[Fineness]:

[Threshold]:
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Select [Sharpness] from the list box and make the
setting.

Picture Style (= Reverts the image to
the original settings

|@ (standard)

v] Browse...

-10.0 €0 60 <40 -20 00 20 4
Contrast:(0) D
Highlight:(0) {1

Shadow: (0) I

(I
(I

[ Linear

Color tone:{0)
Color saturation:{0)

Select [Sharpness]

(lSharpﬂess -
Sharpness

Drag the slider left or right

Displays the value of the setting

|§| The adjustment range is 0 to 10 (in 1-stop increments).

Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make
the setting.

|Picture Style (=]

@ (standard)

v] Browse...

-10.0 80 60 =40 -20 00 20 4
Contrast:(0) i
Highlight:(0) i
Shadow: (D) 1

|:|Linear
(I
(I

Calor tone: (0)
Color saturation:{0)
([Unsharp mask v} Select [Unsharp maSk]

Strenghﬂ:i)— m
Fineness (i'
Threshold m

Drag the slider left or right

Displays the values of the settings

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.145). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

rawl | ReB  JnrjaLo [ LEns

|Tc:ne curve assist

(@B 13 =) Reverts the tone curve
[Tone curve adjustment = to the original settings

fwrss]R][s])[e]
255 High

Standard

u}

Brightness: i 0
Contrast: 1 0
Hue: D 0
Saturation: D 100
Sharpness: [ 0

The tone curve changes as adjusted.

A/
~ -

~@= Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

« Images which have extreme backlighting

@ If you click the [[Z%]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.109).
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Editing Efficiently

Introduction

Editing in the Edit Image Window Edit the image. ]
The thumbnail display and the edit window are combined and images can Change the size
be edited efficiently while quickly switching between images to be edited. Cgr(‘;g‘r;‘geat
Images to be edited are selected beforehand in the main window.
In the main window, select the images you want to edit. Basic
Operation

Switch to the edit image window.

@ Digital Photo P _ _ Ad%ed
1 File Edit Miew Bookmark Label Adjustment Tools Wi Op jon
il : =
ﬁ.- R P — Advanced
Editimage  Folder ool o Selectall  Clearall o o — |mage Ed|t|ng
it il . and Printing
Collection{) Chedima ' = —
- Jeﬁp ; re— Processing
ko i';”e‘ . . Large Numbers
Wl e . : . of Images
lick Select the image to be edited -
Clic The selected image is displayed as an enlargement —
i i i iting
The main window switches to the edit image window. Aihe middle of the window JPEG/TIFF
It may take time for the image to redraw itself. Images
The same tool palette as in the edit window is displayed and you
can edit the image.
" . Reference
To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> + —
<Z> keys.
Index
@ By selecting the [View] menu » [AF Point] in the edit window or edit -

image window, you can display the AF points selected in the camera

at the time of shooting. However, AF points are not displayed for

images whose image size has been changed and then been @ @
converted and saved (p.42, p.136), images for which you selected

an effect other than [Shot settings] as correction of fisheye lens @
distortion aberration, or images which have had settings specified

during RAW processing on the camera for distortion correction and

chromatic aberration correction.
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Double-
click

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.130) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main window] button on
the toolbar.

To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.93).

You can change the enlargement ratio when you double-click
(p-92).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.36).
For a list of edit image window functions, see p.135.
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Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Change thumbnail
position].

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you

to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

File

Open in Edit window
Open in Edit window (enlarged)

Save

Save As...

Add thumbnail to image and save
Convert and save...

Batch process...
Create new folder...

Print...

Print with detailed setting...
Contact Sheet Prints...
Plug-in printing

Ctrl+O

Ctrl+5S
Ctrl+Shift+5
Ctrl+Shift+T

Ctrl+D

Ctrl+B

Ctrl+P

Ctrl+ Alt+P

Ctrl+Shift+P
3

' Add to collection
EMOVE 1T0M CONECLion

Ctrl+G

Clear collection

Delete

Info

Exit

Lirl+5hirt+G

Del
Ctrl+1

Alt+F4

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]

window.

You can also add images to the [Collection] window by selecting
images, right-clicking with your mouse, and selecting [Add to
collection] from the menu that appears.

You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

p

B ®

Selectall  Clearall

133 Documents

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

Fie usteeet ook Wedow  Help

Pk ek Guetsl  Ceswsl o s By Ty

| 3R08 | Adcbe RCE High quaity Recos date: e Phamber of images: 7 Humber of selected images: 1 o

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

|
\\/

:@5 To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, right-
clicking with the mouse, and selecting [Remove from collection] from the
menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by selecting one image, right-
clicking with the mouse, and selecting [Clear collection] from the menu
that appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

|§| You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after exiting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.92).

You cannot use the following functions in the [Collection] window.

« Starting of EOS Utility (p.7), or synchronizing of folders with
EOS Utility
» Batch change the file name of images (p.103)
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range
is only masked in black and the image will not be cropped.

Trimming/angle adjustment window

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

I
vy @&

& & @

Rotate right Quick Stamp  Trimming Batch
check Angle process

Ratng » » = » »

Adjust the angle of the image as needed.

~— Largest

possible
trimming
range

— Click (rotate
image left
or right in
90-degree
increments)

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

I
Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666

pixels in size.

If you click [Center on Screen], you can display the trimming

range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the

image.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming

range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D C, EOS-1D Mark 1V, EOS-1Ds Mark lll, EOS-
1D Mark IIl, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 70D, EOS
60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL
T4i/650D, EOS REBEL T3i/600D or EOS M, the trimming range
based on the aspect ratio information is displayed.
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Select aratio and drag the trimming range.

1102

___Cancel
Select a
trimming
ratio

—Drag the
trimming
range

{704, 362) > (228, 1413) = (1577 £ 1051) [ 1.50)

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.128).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.128).

* Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 70D, EOS 60D,
EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, the set trimming range
based on the aspect ratio information is displayed. Since the image is
not actually trimmed, you can change the trimming range or revert to
the condition before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 70D, EOS 60D,
EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, its trimming range cannot be
changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.*

~
-

When reverting to the condition before trimming is performed based

on the aspect ratio information at the time of shooting, click the

[Reset] button. Also, if you want to cancel all the trimming range, click

the [Clear] button (p.137).

* When shooting with EOS 5D Mark 11l and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually trimmed, even for JPEG images.

A/

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

© For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see

p.137.

R

Introduction

Contents at
a Glance

Basic
Operation

Advaficed
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

40



Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

|§| The recipe (p.98) can be saved as a separate file from the image
and loaded and applied to another image (p.99).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.68) and the dust
erase processing explained in Chapter 3 (p.73 to p.77) can also be
saved in a RAW image.

Select the [File] menu » desired item.

File
Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail te image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing »
Add to collection Ctrl+3
Remaove frem collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+F4

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged]
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T

( Cenvert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5hift+G
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+Fd

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

I
\\ //

=08

-— Select the save

Ltrares destination
A
Compuler
“w —
T o (s )— Click and save
Save o5 type: Exd-JFEG(" JPG." JPEG) = Concel
Quaity setting
Image gualty L
Bty Enter a file name and

Outbut reschition W4

select an image type

Resipe setting
Resize

The RAW image is converted to a JPEG or TIFF image which is

then saved as a new image in the specified save destination.

To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results may
differ very slightly even if with the same RAW image data, or the results of
significant editing of RAW image data with an attached recipe may be different.
When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

5

By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.73 to p.77) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.91, p.92).

You can batch convert and save multiple images (p.101).
For a list of [Convert and save] window functions, see p.136.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment |
Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard
Tone Curve Assist - High

Ctrl+ Alt+Z
Ctrl+Shift+Z

Revert to last saved settings

Revert to shot settings

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (this page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers
(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.
Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

Open in Edit window

Open in Edit window (enlarged)

Save

Save As...

Add thumbnail to image and save

Convert and save...

Batch process...
Create new folder...

Print...

Print with detailed setting...

Contact Sheet Prints...
Plug-in printing

Add to collection
Remove from collection

Clear collection

Delete

Info

Exit

Ctrl+0

Ctrl+5
Ctrl+5Shift+5
Ctrl+Shift+T

Ctrl+D

Ctrl+B

Ctrl+P
Ctrl+Alt+P
Ctrl+5Shift+P

Ctrl+G
Ctrl+5hift+G

Del
Ctrl+1

Alt+F4

Print with Easy-PhotoPrint EX

EPP EX starts up.

In the EPP EX window, select the [File] menu »
[Preferences].

Open... Ctrl+0

Previous Step

Next Step

Save Ctrl+5
Save As...

Preferences...

Frint... Ctrl+F

My Recent Files

Exit

The [Preferences] window appears.

In [Print Quality], select [Quality Priority], click the
[Option] button. In the dialog box that appears,
checkmark [Print with the best quality].

Preferences
Print | Advanced
||
[ Spoal print job page by page
| Number of copies : 1 | Copies

Printing Order : [ByDate -]

Amount of extension of borderless printing : Default -

Print Quality : Quality Priority ) S e I e Ct
Quality

Priority
[ oK J [ Cancel ] [ Help ]

Click and checkmark [Print with the best quality]
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Introduction

Select the [Advanced] tab, checkmark [Enable ICC Select the paper type, and then click the [Layout/
profile], and then click the [OK] button. Print] button.
The [Preferences] window closes. e Contents at
. . i, St a Glance
Specify the number of sheets to be printed, and then — N — eafmia SRR
click [Select Paper]. e T
EPP EX E :,,.,:m.. "-_ -i—'!— | ' Basic
N 0 [ o W@ [| Operation
= e THA - e et \ )
g mm, 06 O Select the
| = = N e paper size
and type
ﬂ- S na ]
S B S S = S L Click to ‘ =
th Advanced
&m“ ‘ dg = Ir?lf;]esesreofe Image Editing
- . I ‘ and Printing
sheets to be H'I; -~
h printed == N ) : Processing
I e Click Large Numbers
. of Images
* o N SpeC|fy the layout, and then click the [Print] button.
= et bl e = - . Sing
I JPEG/TIFF
Click Exif Print Images
Select the
layout Reference
—
Index
_
—_— = = ﬁﬂlhﬂkﬁ[ﬂnj-&d! @@
{{ o || -
Cllck to prlnt @

Printing begins.
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Introduction

"2 Additional information Printing Photographs with Canon Inkjet

Print up to 1000 images at a time Printers Compatible with Easy-PhotoPrint

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

Contents at
You can perform the following types of photograph printing with Canon a Glance

inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP"):

The printed image’s color is not what you expected Simple printing of RAW images
In the EPP EX window, select [Preferences] in the [File] menu and High quality printing using the color reproduction range of Adobe RGB - Be"’r‘Z[{‘.’on
then click the [Advanced] tab in the [Preferences] window to display and a Canon inkjet printer perati
the [Advanced] tab sheet.
In the [Advanced] tab sheet, select [Enable ICC profile] in [Color To perform this printing, it is necessary to first install EPP version 3.5 or
correction for printing] and try printing using the [Perceptual] setting later on your computer. When using an Easy-PhotoPrint EX-compatible
(p.146). inkjet printer, it is recommended that you print using Easy-PhotoPrint EX
(p.43).
e o . N Advanced
and Printin
Printing with faithful colors 2
When the color space (p.146) is set to SRGB or Adobe RGB (p.78, Start up EPP. .
95), this color space is automatically transmitted from DPP to EPP 1 T ; ; processing
p.=2), IS pace _ ; y Select the [File] menu » [Plug-in printing] » [Print with Easy- Large Numbers
EX, allowing you to print with faithful colors. PhotoPrint] of Images
When the color space is set to Apple RGB or ColorMatch RGB, the '
image is printed with an sSRGB color space, and when set to Wide Editing
Gamut RGB, with an Adobe RGB color space. Open in Edit window Ctri+O JPEG/TIFF
Printing with a wide color reproduction Open in Edit windaw (zrlarged) LinEles
When the color space setting (p.78, p.95) is set to Adobe RGB and save Ctrl+5 _
the image is printed with a Canon inkjet printer, the color reproduction savefs.. Cerl+Shift+S
range is wider, and green and blue in particular are reproduced 23:5:;2:‘;‘3'5';:;“93 and save Et::iéh'&” Reference
vividly. Batch process... Ctrl+B
Create new folder...
|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.88). Brink Culep Index
Print with detailed setting... CEr+AIL+P —
Zonkact Sheet Prints, . Ctrl+Shift+P
M Print with Easy-PhotoPrint Chrl+E
&dd to collection Chrl+a @ @
Remowe From calleckion Ctrl+5hift+G

EPP starts up.
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Introduction
In the EPP window, select the [File] menu » Select the [Advanced] tab sheet and check that the
[Preferences]. EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation Contents at
function may prevent images being printed with faithful color a Glance
Preferences. . reproduction —
Exit: P )
Th P f . d Pnces [g| Basic
e [Preferences] window appears. Pint | Advanced | Operation
. . . o —— _ If checked
In [Print Quality], select [Quality Priority]. mage (Eppinizs mages automticaly . ’ —
[ Q y] [Q y y] ppl_l,l Rotate/Trimming to the same images in the same manner C“Ck tO
Preferences D_?| “When landscape images are rotated depending on the selected lapout remove the
T oo (%) Rotate Left
o |Ad il () Rotate Right CheCk mark
["] Spoal print job page by page
Layout [ &hways tim when you select the layout with the margins
Nunbeioboonizzg Copies ’ [ et r:algins ta th:minimum when:ou select the Iayiut with the margins
Pinting Order : |B-"' Date o | Print filenarne when you select the index in layout Advan Ced
Amount of extension of barderless printing : . Image Edltlng
Piit Gualiy - Select [¥] Preview all lapouts of &4 and Letter and P“ntlng
. A ¥ N —
Qual |ty ISrngag;\on Select images from multiple folders ]
Priority Click to Processing
- - close the Large Numbers
window  of Images
[[ Ok ]:I Cancel ] [ Help ]
Editing
. . JPEGI/TIFF
£ Specify the number of sheets to be printed, and then Images
. D —
[ 0k ] [ Cancel ] [ Help ] CIICk [NeXt] '
. Reference
—
— Click
Index
increase the
number of
sheets to be

printed @

Fapes 508 - 4t 1015 Medka Trpe : Fhotn Pages Pro 15 Fageis)




Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

Click

Select the
paper type

FasPis (Gt Fharsapes  Mate Pt Pager
Gy

Papes S 4riin 1Paget)

Click to print

Select the layout

=» Printing begins.

2 Additional information

@ Print up to 1000 images at atime
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.94) to
[Perceptual] (p.146) and print.

-2@/3 Printing with a wide color reproduction

When the color space (p.78, p.94) is set to Adobe RGB and the image is
printed with Canon inkjet printer, the color reproduction area widens,
and green and blue in particular are reproduced vividly.

When the color space is set to Apple RGB or ColorMatch RGB, the
image is printed with an sSRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.88).
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Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

File

Open in Edit window Ctrl+ 0
Open in Edit window (enlarged)

Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save.., Ctrl+D
Batch process... Ctrl+B
Create new folder...

( Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Centact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remaovwe from collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+F4

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.

Printing begins.

Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

File

Open in Edit window Ctrl+ 0
Open in Edit window (enlarged)

Save Ctrl+5
Save As... Ctrl+Shift+5S
Add thumbnail te image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5Shift+G

Clear collection

( Delete Del
Info Ctrl+1
Exit Alt+F4

The [Confirm File Delete] dialog box appears.

Click the [Yes] button.
The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.
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Introduction

Creating a Folder for Saving Images Moving Images N
You can create a folder for sorting images. You can move or copy images to a separate folder and sort by shooting Contents at
date or themes. a Glance
In the folder area, select the location where the new
folder is to be created. Drag the image to be moved or copied.
e To move: Drag the image and release when the image is in the Basic
JLE ol Photo Bl L Operation
Blerm EditesView T —— H destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
e sEee i release when the image is in the destination folder. AdvDced
Folier B o T e —————————————— Opegftion
O
= Select all Clear all otate left  Rota| A d V an C e d
Image Editing
T and Printing
. || P Desktop S ——
Select the [File] menu » [Create new folder]. F e
File b D Processing
Open in Edit window Ctrl+ 0 E‘% | Photo La.rge NumberS
Open in Edit window (enlarged) IE‘“Sa.mpIEP\L‘turEs Of lmages
Save Ctrl+5 o@@ E:S;D:up
Save As.. Ctrl+Shift+S gl _ ¢ & . Jlféjlet;_ll]lgFF
Add thumbnail to image and save Ctrl+Shift+T S Network L~
Convert and save... Ctrl+D o Travel 4/ |mages
Batch process... Ctrl+B 3 . —
[ Crostenewfolder.. The images are moved or copied to the destination folder.
Print... Ctrl+P Reference
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P —
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+Shift+G IndeX
Clear collection - )
Delete Del
Info Ctrl+1
Exit Alt+F4 @ @
The [Create new folder] dialog box appears. @
Enter a folder name and click the [OK] button. o

The new folder is created in the folder selected in step 1.



Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.

R

Introduction
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Contents at

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

stment Tools Window p

B ® 9P

Seleciall  Clearall  Rotsie bt Rots

Folder Collection(0)

B Deskiop
- Libraries

- Documents
@ -l Music

Ef :

a
- Videos
& Homegroup
(/& CANON
-8 Computer
- € Network
- Jy Travel

The folders are moved or copied to the destination folder.

Registered folders appear by clicking the [Bookmark] menu. a Glance
Select the folder for which a bookmark is to be
; Basic
eglstered. Operation

Bl Desktop
(=) Libraries

% Documents
g Music
- Pict

Select

-4 Homegroup
@B CANON
48| Computer

Y |

"% Select the [Bookmark] menu » [Add].

“= <> The folder selected in step 1 is registered in the [Bookmark]
menu.

Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

-
HE
o
HE
=

IMG_0001.CR2

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic Using the Digital Lens Optimizer ...........ccccccceeeeeeen. 69
dust erasure processing, various printing functions for printing out work, Compatible Cameras..........cccuvvveeeiiiiiiiiee e 69
and color management are explained here, geared to the user who is Compatible LENSES.......coovviiiiiiiiiiiieeeeee e 69
competent in the handling of third-party image editing software. ) L. Lo
Using the Digital Lens Optimizer.........ccccccceevveeeeeennnnns 70
Adjusting While Comparing with the Original Image... 53 Performing Automatic Dust Erasure Processing ..... 73
Changing How the Window is Split............cc.cccevee.... 53 Compatible Cameras.........cccovvviiiieeviiie e, 73
Adjusting by Comparing Multiple Images................. 54 Automatic Dust Erasure Processing in the Main Window... 75
Displaying an Area Beyond the Set Range as a Manually Erasing Dust (Repair Function)................ 75
Warning Indicator (Highlight/Shadow Warning) ....... 55 Erasir_mg Unwanted Parts of an Image (Copy Stamp
Performing Advanced Editing.............o..oovvveovvve. 56 FUNCHION)....iiiiicce e 77
Adjusting White Balance with Color Temperature ..... 56 Transferring a RAW Image to Photoshop................ 78
Tuning White Balance with Color Wheel ................... 56 Setting Work Color Space ............ccccceevvivinieniinenn. 78
Adjusting Dynamic RaNge ...........coceeviveeeiiiiieeeniieennn S7 Compositing IMages.........covivviiiiiiiieeeeeie e 78
Adjusting Brightness of Shadows/Highlights ............. 57 Compositing Methods............cceiiiiiiiiiieiic e, 82
Tone Curve Adjustment............cccovvveviiiiiieiiiiieeeeeeiee, 58 Creating HDR (High Dynamic Range) Images........ 82
Example of a Tone Curve Operation .................... 59 Starting Up Map ULty .........cocveeieiiereceeceeecee e 85
Using a Picture Style File........ccoooii, 59 Printing with Shooting INforMation............................ 36
About the RGB Tool Palette ...........ccoovvvvvvviiiiiiiiinnee, 60

Printing a Thumbnail List (Contact Sheet Printing).. 87

Using 'Fhe AuFo Lighting Optimizer..........ccccccceeeeennn. 61 Printing RAW Images on a High-End Canon Printer.. 88
Reducing NOISE............ccccviiiiiiiiiiii 62 Printing with a High-End Canon Inkjet Printer ............ 88
Correcting Lens Aberration ..........cccoeevvevviiieieeeeennnnnn. 63 Printing with DPP and Easy-PhotoPrint Pro............ 88
Compat!ble Cameras........ccccoeveeiiiiiiie 63 Printing with DPP and Print Studio Pro ................ 89
Compatible LENSES ..o 63 Printing with a Large-Format Canon Printer ............. 90
Making COITECHIONS........uvviiiiiiiieiiiiiiieeee e 65 Specifying Preferences 90
Effects of Distortion Aberration Correction for Fisheye P g T
General Settings...........cooooeeeiiiii, 91
LENSES ..o 66 View Seti 92
About Shooting Distance Information Slider ............ 63 T:)e(;/lvpjel?gs .............................................................. o
Correcting Multiple Images at a Time ................... 63 TOOIPAIBUE ..o

Color Management.............ccooeeeeeiiiiiiiiiiee 94
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Adjusting While Comparing with the Original Image

Introduction
You can display before and after versions of an adjusted image in the

same window and adjust while checking the adjustment results. Changlng How the Window is Sp“t —
You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Before/ Contents at

after Comparison]_ In the edit window, select the [VleW] menu » [Dlsplay R
mode] » [Split single image].
= Basic

Operation
—_—

Advanced

Operation

Imag\(ajltmg
and PPinting

=» One image is divided and displayed on the left and right or top
and bottom. Processing

© To switch between top and bottom, and left and right, perform the Large Numbers

Change the image display. same operation as step 2 on the left page. __ofImages

The image divides into a left and right window.
The window on the right shows the image after editing.

Select the [View] menu » [Change up/down/left/right] » [Up/ Editing

down]. JPEGITIFF
_ Images

|

Reference

|

Index

|

The layout of the two images changes to top and bottom. @ @
The bottom window shows the image after editing. @

|§| Images can also be displayed in the edit image window by the same
operation.



Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and
adjust images while comparing them with each other.

In the edit window, display the multiple images to be
compared.

Align the images.

Select the [Window] menu » [Arrange vertically] or [Arrange
horizontally].

The edit windows are aligned.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

The other edit windows will also be displayed in the same
position/enlargement ratio.

Move the display position.
If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
other edit windows.
To cancel synchronization, select the [Window] menu »
[Synchronize] again.

|§| Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the
image has exceeded that set range, you can display the highlighted part
in red and the shaded part in blue.

Select the [Tools] menu » [Preferences].
Select the [View settings] tab sheet.

Enter the warning value for [Highlight] and [Shadow].

- "
Preferences et S|
i General settings View settings | Tool palette I Color management |
Grid pitch
64 Pixels(8-256)
Image selection status
Images opened in Edit window remain selected in main window
Magnification in Edit window
@ Fit to window ) 50% ) 100% () 200%
Magnification when the Edit/Edit image window is doubledicked
©) 50% @ 100% () 200%

RAW and JPEG

["Display only CR.2 images for CR2 and JPEG files of the same name:

Sort order in main window
[] Retain sort order
Highlight/shadow Alert
Highiicht 255 192-255) .

Shadow 0 0-64) .

Quick check tool display

@ 50% (7 100% (moiré reduction off)

Click the [OK] button to close the window.

Display the edit window.

Select the [View] menu » [Highlight]. Similarly, select
[Shadow].
On the opened image, if there is an area that exceeds the value
entered in step 3, the highlighted part of that area is displayed in
red and the shaded part is displayed in blue.

|§| You can also display the warning with the same operation in the edit
image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.
Adjustments made using the high-level functions of the [RAW] and

[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS]
tool palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

RAW |pgB | nr/aLo |LEns |

| Brightness adjustment [3”
0 0.00

White balance adjustment [EH

] 213)

mortemperamre_ - _FJI Tune... I
%] [ssnu K}

Drag the slider left or right

— Displays the value of the
setting

|§| The adjustment range is 2500 to 10000K (in 100K increments).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.
Tune by dragging a point.

You can also fine-tune your adjustment by directly entering the
adjustment values.

Cancel

Calor tone:
— Enter the values to set
Color saturation:

= —

©

Drag

® To register adjustment results as personal white balance (p.100),
select a setting other than [ @& ()] from the [White balance
adjustment] list box, and then tune with the color wheel. You
cannot register the adjustment results as personal white balance
when you have selected [g& ()] from the list box and have done
any tuning.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| The adjustment range of color tone is 0 to 359 (1 increment in
numerical value input), and the adjustment range of color saturation
is 0 to 255 (1 increment in numerical value input).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

[Picture Style (=]
@ (standard) |

- l[ Browse...

>

Move downwards
Output highlight points

Move to the left or rignt
Input highlight points

———

-10.0
Contrast:(0)
Highlight: (0
Sfadljw'[fn} Move upwards
" Fluinear Output shadow points

Color tone:(0)

Color saturation:{0)

[Unsharp mask v]
Strength:(0)

Fineness:{0)

- I}
I
[
[
1}

N

[

[

Threshald:{0)

Move to the left or right
Input shadow points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Adjusting Brightness of Shadows/Highlights

You can adjust the brightness of shadows and highlights in an image.
By adjusting shadows and highlights in an image with a restricted
brightness, you can reduce the effects of clipping in shadows and
highlights.

Picture Style (=]
@ (Standard)

vl Browse...

-10,0 8.0 6.0 40 -20 0.0 20 40
Contrast: (0)

Highlight: (0) . @ | I?rag the sliders left or
@) right

Shadow:{0)
|:| Linear

Color tone:(0)

Color saturation:{0)

[Unsharp mask vl
Strength: (D)
Fineness: ()
Threshold: (0) I

=2 =2

Introduction

—_—

Contents at
a Glance
D ————————

Basic
Operation

—

Advanced
Operation

Imag\(gjltmg
and PPinting

Processing
Large Numbers

of Images
—_—

Editing
JPEG/TIFF

Images
—

Reference

57



Introduction

Tone Curve Adjustment Make adjustments. —
You can adjust the brightness, contrast and color of a specific area by RAW | RGD NR/ALO | LENS |
changing the tone curve (p.145). [Tone curve assist (D) ()i Cgrgﬁinr;cgeat
|T0ne curve adjustment |
In the tool palette, select the [RGB] tab sheet. ke J(r](c](s))
255 | Adjusts each channel Basic
' ' Batch adjusts RGB SRS T
Select the tone curve mode and interpolation ]
method.
RAW | RGB  |NR/ALO | LENS | ég\é?gt(i:gﬁ
|Tone curve assist | Click to add a [[] (point)
|Tc:ne curve adjustment | AdeSt by dragging [D]
)] Imaga,,tmg
255 and PPfting
0 Processing
Large Numbers
of Images
@ Curve Brightness: D u] —
Straight . . . Contrast: [ o C
H Right-click with the z Editing
@ || REEREE mouse inside the graph - 0 ; J'TrEg/L'SFF
Lo sk to display the menu ' __mages
Saturation: D 100
Sharpness: I 0 Reference
0 ’
: - The horizontal axis shows the input level and the vertical axis
B 0 0 shows the output level.
Contrast: i 0 The maximum number of [[J] is 8. Index

To delete a [[]], either press the <Del> key or double-click on the [[(J]. “—r’

Hue: D @ a

Saturation: ] @ 100

Sharpness: 1} 0 @ @
|§| The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any @
adjustments (p.93).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.93).
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Example of a Tone Curve Operation
Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon Web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

|Pi-:mre Style
[ﬁ (Standard) -

Browse...

-10.0 8.0 %0 40 -20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

|§| The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only. Furthermore, you cannot apply
Picture Style files with the extension “.PSE” to an image; however if
such a file is registered in the camera and the image is shot, the
image will display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALQO] and [LENS] tab sheets according to your
editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette
other than tone curve adjustment.

== Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette
(p.131) when applying the Auto Lighting Optimizer (p.61), reducing
noise (p.62) or correcting aberration (p.63) after you have made any
required adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer _
Introduction
If the shooting result is dark or the contrast is low, you can use the Auto Checkmark the checkbox.
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image. Raw [RGB | NRIALO [LENS |
You can also change the settings of the image shot with the camera’s || suto Lighting Optimizer | Checkmark Cgrg;a;r;cgeat
Auto Lighting Optimizer function. 0
This function is compatible only with RAW images shot with EOS-1D X, Low Standard Strong
EOS-1D C, EOS-1D Mark IV, EOS 5D Mark Ill, EOS 5D Mark Il, EOS Basic
6D, EOS 7D, EOS 70D, EOS 60D, EOS 50D, EOS REBEL T5i/700D, For images shot with the camera’s Auto Lighting Optimizer Operation
EOS REBEL SLl/lOOD, EOS REBEL T4|/650D, EOS REBEL T3|/600D, function, the checkbox is a|ready checked.
EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS REBEL T3/1100D . )
and EOS M. Change the settings according to your preferences. A
* ALO stands for Auto Lighting Optimizer. "W | rn | MR s | Ol
) [ Awute Lighting Optimi
Select the [NR/ALO] tab sheet from the tool palette in i| —= ng > = | Advemced
the edit window or edit image window. = Select from three levels: Imag%“_ting
oW Standard Strong and ntlng
= Low/Standard/Strong
rew | Rae ([ _MRIALO [JEns |
I Auto Lighting Optimizer | Auto correction is applied to the image to match the settings. Processing
7 0 For images shot with the camera’s Auto Lighting Optimizer Large Numbers
s function, the settings at the time of shooting are applied as the of Images
|N0ise reduction Apply | defaUIt Values-
. N — Editing
. e To cancel the Auto Lighting Optimizer, remove the check mark JPEG/TIEF
from the checkbox. Images
Luminance noise reduction:{1)
o - 20
Chrominance noise reduction:{3)
0 0 20 Reference
TIFF/IPEG
Index

® When [Highlight tone priority] is set to [Enable] in EOS-1D X,
EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS 7D, EQOS 70D, EOS
60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS @ @
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D,
EOS REBEL T3/1100D and EOS M, the Auto Lighting Optimizer
function cannot be set.
You cannot use the Auto Lighting Optimizer with multiple-

exposure RAW images created on the camera. 61



Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high 1ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/ALQO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.

‘ Moise reduction Apply |

[ [ MR. Preview... ]

RANY

The [NR Preview] window appears.

Adjust an image.

Cancel

Navigator
window

—Enlargement
display
Raw position

Luminance noise rj n:(7)

(] i 0
Chrominance noise, tion: (8)

1] D n

Drag the
sliders

NR checkI window

You can set a noise reduction level from within a range of 0 to 20.

The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

"2 The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.91) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

Vi
Q= To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.131) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

i

You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.93).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high 1SO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise reduction] has been set, resolution may be

reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

For a list of [NR Preview] window functions, see p.133.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D X EOS-1D C

EOS-1Ds Mark 111 EOS-1D Mark 1l
EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D EOS 5D Mark Il

EOS 5D*1 EOS 6D

EOS 70D EOS 60D

EOS 40D EOS 30D*?

EOS REBEL SL1/100D EOS REBEL T4i/650D
EOS REBEL EOS REBEL
T2i/550D T1i/500D

EOS DIGITAL REBEL EOS REBEL

XTi/400D DIGITAL
EOS M

T3/1100D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EOS-1D Mark IV
EOS-1D Mark II N
EOS-1Ds

EOS 5D Mark II

EOS 7D

EOS 50D

EOS REBEL T5i/700D
EOS REBEL T3i/600D

EOS DIGITAL REBEL
XSi/450D

EOS DIGITAL REBEL
XS/1000D

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses

EF 14mm f/2.8L USM

EF 8-15mm f/4L USM Fisheye*3
EF 20mm /2.8 USM

EF 24mm f/1.4L 1l USM*3

EF 24mm /2.8 IS USM*3

EF 28mm /2.8

EF 35mm f/1.4L USM

EF 35mm f/2 IS USM*3

EF 14mm f/2.8L Il USM*3
EF 15mm /2.8 Fisheye*3
EF 24mm f/1.4L USM

EF 24mm /2.8

EF 28mm /1.8 USM

EF 28mm /2.8 IS USM*3
EF 35mm f/2

Standard and medium telephoto lenses

EF 40mm /2.8 STM*3
EF 50mm f/1.4 USM

EF 50mm /1.8 II

EF 85mm f/1.2L Il USM*>
EF 100mm f/2 USM

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

Telephoto lenses

EF 135mm f/2L USM

EF 200mm /2L IS USM*3
EF 200mm /2.8L 1l USM
EF 300mm f/2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm f/5.6L USM

EF 500mm /4L IS USM

EF 600mm /4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm /2.8L USM

EF 300mm f/2.8L IS Il USM*3
EF 300mm /4L IS USM

EF 400mm f/2.8L IS Il USM*3
EF 400mm /4 DO IS USM
EF 500mm f/4L IS 1l USM*3
EF 600mm /AL IS Il USM*3
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Zoom lenses

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm f/3.5-4.5 USM

EF 24-70mm f/2.8L Il USM*3
EF 24-85mm f/3.5-4.5 USM

EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 Il USM

EF 28-90mm f/4-5.6 1l

EF 28-105mm /3.5-4.5 USM
EF 28-105mm /4-5.6 USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm /3.5-5.6 USM
EF 55-200mm f/4.5-5.6 1l USM
EF 70-200mm /2.8L USM

EF 70-200mm f/2.8L IS Il USM*3
EF 70-200mm f/4L IS USM*4
EF 70-300mm /4-5.6 IS USM
EF 75-300mm f/4-5.6 11*3

EF 75-300mm f/4-5.6 USM

EF 75-300mm /4-5.6 IIl USM
EF 90-300mm /4.5-5.6 USM
EF 100-400mm /4.5-5.6L IS USM

EF 16-35mm f/2.8L Il USM*3

EF 17-40mm /4L USM

EF 24-70mm f/2.8L USM

EF 24-70mm f/4L 1S USM*3

EF 24-105mm f/4L IS USM

EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 IlI

EF 28-105mm f/3.5-4.5 Il USM
EF 28-105mm f/4-5.6

EF 28-200mm /3.5-5.6

EF 28-300mm f/3.5-5.6L IS USM
EF 55-200mm f/4-5.6 USM

EF 70-200mm f/2.8L IS USM

EF 70-200mm f/4L USM

EF 70-300mm f/4-5.6L IS USM*3
EF 70-300mm f/4.5-5.6 DO IS USM
EF 75-300mm f/4-5.6 11I*3

EF 75-300mm f/4-5.6 Il USM

EF 90-300mm f/4.5-5.6

EF 100-300mm f/4.5-5.6 USM

Macro lenses

EF 50mm f/2.5 Compact Macro*3

EF 100mm /2.8 Macro USM

EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm /2.8 Macro USM EF-S 10-22mm /3.5-4.5 USM
EF-S 15-85mm /3.5-5.6 IS USM*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 IS USM
EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm f/3.5-5.6 I11*3

EF-S 18-55mm f/3.5-5.6 I
EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM  EF-S 18-55mm f/3.5-5.6 IS*3
EF-S 18-55mm f/3.5-5.6 IS II*3 EF-S 18-135mm f/3.5-5.6 1S*3
EF-S 18-135mm f/3.5-5.6 IS STM*3 EF-S 18-200mm f/3.5-5.6 1S*3
EF-S 55-250mm f/4-5.6 1S*3 EF-S 55-250mm f/4-5.6 IS [1*3

EF-M lenses
EF-M 22mm f/l2 STM

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EQS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*> EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens

even when the extender is attached.
You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot

with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.

EF-S 18-55mm f/3.5-5.6 IS STM*3
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Making Corrections Checkmark the items to be corrected.

You can make corrections to any of the four aberrations as below, either

one at a time or simultaneously. Contents at

. . o a Glance
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image) Basic
Color blur (blue or red color blur which sometimes occurs at the edge Operation
of the highlighted area of an image)
Distortions
Advanced
(0] ti
In the tool palette, select the [LENS] tab sheet. peration

Click the [Tune] button.

Advapced
Imag iting
and Pfinting

RAW |RGE | NRJALO | LENS |
| Digital Lens Optimizer Tune. .. |
it o The image is corrected and redisplayed. Processing
Check the results of corrections to peripheral illumination or Large Numbers
Lens data ¢ No . . . . of |mageS
distortions in the full view.
[ tpten, ] Check the results of corrections to chromatic aberration and color —
(Lo sbrrai v C . blur py clicking the area on the imagg you want to che(_:k. In the JFFgclst/I'rl]'PFF
top right of the window, the area is displayed at 200% in the Images
Peripheral ilumination OFF enlargement display section (p.138).
Chromatic aberration OFF You can lessen the degree of correction by moving the slider to
Color blur OFF the left for the item you want to correct. Ref
istortion orF You can respectively correct red chromatic aberration with the [R] eterence
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.
To correct distortion aberration of images shot with a fisheye lens e
(EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four

effects can be selected from the [Effect] list box in addition to ——
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].
For detailed information on each effect, see “Effects of Distortion

Aberration Correction for Fisheye Lenses” (p.66).

65

The [Lens aberration correction] window appears.
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Introduction
For images shot with EF 8-15mm f/4L USM Fisheye, a fine-tune Effects of Distortion Aberration Correction for
slider is also displayed when you select [Emphasize Linearity] :
from the [Effect] list box. FISheye Lenses
Adjust the amount of correction for distortion aberration with the Shot settings Cglg;%;r;tgeat
adjustment slider, and then adjust with the fine-tune slider if more By selecting this option, only distortion aberration correction for
adjustment' is required. _ o correcting optical distortion is performed.
When the list box for selecting an extender is displayed, select Basi
the extender attached at the time of shooting from the list box. Ope"’rlgl{fon
Click the [OK] button.
The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the Advanced
image is redisplayed. Operation

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

Advapced
In the main window, the [ g}¥ ] mark is displayed on the image to Imag\gji_ting
indicate the lens aberration corrections (p.128). and Pfinting
Processing
Emphasize Linearity Large Numbers
of Images

This converts the image to a “central projection” style image. This
projection method is used with general lenses. —
Differing from fisheye lenses, central projection displays straight lines JFFgclst/I'rl]'PFF
as straight lines. By selecting this option, a wide-view panoramic Images
image can be obtained. However, the periphery is stretched, resulting

in decreased resolution.

& ' Reference
- V4

Index
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Emphasize Distance

This converts the image to an “equidistant projection” style image.
This projection method preserves distance relationships.

Equidistant projection displays the same distances from the center to
the periphery as the same distances. In particular, when shooting a
celestial body such as the celestial sphere, any height above the
horizon (declination) is captured at an equal interval. This method is
therefore used in such photography as celestial photography (star
maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

© While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

The distance cannot be minutely adjusted by using the slider for images
shot with an EF-M lens. (The slider is not displayed.)

EOS-1D X EOS-1D C EOS-1D Mark IV
EOS-1Ds Mark 11l EOS-1D Mark Il EOS 5D Mark IlI

EOS 5D Mark I EOS 6D EOS 7D

EOS 70D EOS 60D EOS 50D

EOS 40D EOS REBEL T5i/700D EOS REBEL SL1/100D

EOS REBEL T4i/650D EOS REBEL T3i/600D EOS REBEL T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS REBEL
T1i/500D XSi/450D T3/1100D
EOS DIGITAL REBEL EOS M L
XS/1000D

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL
For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].
[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool

palette by clicking the [Tool Palette] button (p.126) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you

can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise

reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-312).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.30) and/or the color saturation (p.109) to
make the color deeper.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| For a list of the [Lens aberration correction] window functions, see
p.138.
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Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena
that are unavoidable as long as light must pass through the lens. These
optical phenomena cannot be corrected under [Lens aberration
correction] (p.63). Correction is achieved using the designed value of
each lens. The images that can be corrected are RAW images shot
using any of the following “compatible cameras” and “compatible
lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected.
To use this function, [Lens data] for the lens used to shoot images first
needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set
[Sharpness] or [Strength] for [Unsharp mask] for images to O.

Compatible Cameras

EOS-1D X EOS-1D C EOS-1D Mark IV

EOS-1Ds Mark Il EOS-1D Mark IlI EOS-1D Mark II N

EOS-1Ds Mark Il EOS-1D Mark Il EOS-1Ds

EOS-1D EOS 5D Mark Il EOS 5D Mark Il

EOS 5D*1 EOS 6D EOS 7D

EOS 70D EOS 60D EOS 50D

EOS 40D EOS 30D*2 EOS REBEL
T5i/700D

EOS REBEL EOS REBEL EOS REBEL

SL1/100D T4i/650D T3i/600D

EOS REBEL EOS REBEL EOS DIGITAL REBEL

T2i/550D T1i/500D XSi/450D

EOS DIGITAL REBEL EOS REBEL EOS DIGITAL REBEL

XTi/400D DIGITAL T3/1100D XS/1000D

EOS M — —

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Wide angle lenses
EF 14mm f/2.8L 1l USM
EF 24mm f/1.4L 1l USM
EF 24mm /2.8 IS USM
EF 28mm /2.8 IS USM
EF 35mm f/2 IS USM

EF 14mm f/2.8L USM
EF 20mm /2.8 USM
EF 24mm f/1.4L USM
EF 28mm /1.8 USM
EF 35mm f/1.4L USM

Standard and medium telephoto lenses
EF 40mm /2.8 STM EF 50mm /1.4 USM
EF 50mm f/1.2L USM EF 85mm f/1.2L USM
EF 85mm f/1.2L 1l USM EF 85mm /1.8 USM

Telephoto lenses

EF 300mm f/2.8L IS 1l USM
EF 400mm f/2.8L IS 1l USM
EF 600mm /4L IS Il USM

EF 135mm /2L USM
EF 300mm /4L IS USM
EF 500mm /4L IS Il USM

Zoom lenses

EF 16-35mm f/2.8L Il USM

EF 24-70mm f/2.8L USM
EF 24-70mm f/2.8L Il USM EF 24-70mm f/4L IS USM
EF 24-105mm f/4L IS USM EF 28-70mm f/2.8L USM
EF 28-135mm f/3.5-5.6 IS USM  EF 28-200mm {/3.5-5.6 USM
EF 28-200mm /3.5-5.6 EF 28-300mm f/3.5-5.6L IS USM
EF 70-200mm f/2.8L USM EF 70-200mm f/2.8L IS USM
EF 70-200mm f/2.8L IS Il USM  EF 70-200mm f/4L USM
EF 70-200mm f/4L IS USM EF 70-300mm f/4-5.6L IS USM
EF 70-300mm f/4.5-5.6 DO IS USM EF 70-300mm f/4-5.6 IS USM
EF 100-400mm f/4.5-5.6L IS USM —

EF 16-35mm f/2.8L USM
EF 17-40mm /4L USM
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Macro lenses
EF 100mm /2.8 Macro USM EF 100mm f/2.8L Macro IS USM

EF-S lenses
EF-S 55-250mm f/4-5.6 IS I EF-S 55-250mm f/4-5.6 IS
EF-S 10-22mm f/3.5-4.5 USM EF-S 15-85mm f/3.5-5.6 IS USM
EF-S 18-55mm /3.5-5.6 Il USM  EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il EF-S 18-55mm f/3.5-5.6 |l
EF-S 18-55mm f/3.5-5.6 EF-S 18-55mm f/3.5-5.6 IS Il
EF-S 18-55mm f/3.5-5.6 IS EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 ISUSM  EF-S 18-55mm f/3.5-5.6 IS STM
EF-S 18-135mm /3.5-5.6 IS EF-S 18-135mm f/3.5-5.6 IS STM
EF-S 18-200mm /3.5-5.6 IS —

EF-M lenses

EF-M 22mm /2 STM EF-M 18-55mm 1/3.5-5.6 IS STM

® The Digital Lens Optimizer is also available for images shot with
an extender mounted on a compatible lens.

You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.

Using the Digital Lens Optimizer

In the tool palette, select the [LENS] tab sheet, and
check the status of [Lens data] for [Digital Lens
Optimizer].

RAW | RGB | NR/ALO | LENS |

| Digital Lens Optimizer Tune... |

Setking OFF
Lens data : Mo '
Update. ..

| Lens aberration carrection | Tune. .. ||
4 [l

[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [NO] is displayed, proceed to step 2. To use the function, you
need to download [Lens data] for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the [Info] button in the toolbar on the main window (p.23).
You can also check it with the menu that appears when you right-
click with the mouse on an image.

If [Yes] is displayed, proceed to step 4.

|§| Before you click the [Update] button in step 2, Lens data [No] may

be displayed instead of [Not Available] for non-compatible images.
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Introduction
Click the [Update] button. Checkmark the checkbox for the lens used to shoot
S [Ra el B | the image, and click the [Start] button.
|Digita| Lens Optimizer Ture. .. | (@ Add or Remove lens Contents at
a Glance
Setting OFF [_|EF14mm F2.8L T USM . ]
| |EF24mm F1.4L II USM
| |eF3smm F1.4L usM
Lens data: Mo [_|eFs0omm F1.20 usm Basic
B e Operation
; EF300mm F2.8L IS II USM
|Lens aberration correction Tune... |I i::’gg:z EiBII:SIISI IUISL:M
The [Add or Remove lens data] window appears. ior 16 3o 2.0 11 U5 Advanced
[ |EF16-35mm F2.5L USM Operatlon
| |eF 17-40mm FaL usm
: EF24-70mm F2.8L IT USM
| |eF24-70mm F2.8L UsM
: EF24-105mm F4L IS USM
;EFZB-3OUmm F3.5-5.6L IS USM Imag\%””]g
Fe . and Pfinting
=300mim F45. Processing
’_|EFlo04DDmm F4,5-5.6L IS USM N i La.rge NumberS
Add: 1/Delete: 0 [[ Start ]! Cancel ] Of ImageS
—_—
=» The lens data is downloaded to your computer. Editing
When the downloading of the lens data ends, the indication for JlTrEgéEsFF
[Lens data] changes to [Yes]. e
You can download the data for up to 30 lenses at the same time.
If you remove the check mark from the checkbox for already- Reference
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.
Index
D —————————
® To use this function, an environment with Internet access @
(subscription to a provider, browser software installed and an in- @ Depending on the type, current state, etc. of software running on

your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.

place line connection) is required.

An administrator-level privilege is required for this operation.
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Click the [Tune] button.

RAW |RGE | mRjaLo | LEMS |

| Digital Lens Optimizer I[ Tune... ] 1

Setting OFF

Lens data : Yes ||

The [Digital Lens Optimizer] window appears.

Checkmark the [Setting] checkbox and adjust the
image.

;

Introduction

—_—

Contents at
a Glance
D ————————

Basic
Operation

—

Advanced

Operation

- | BEEEE
I [v] 100
o not sharpen previews ProceSSing
oo ot serpenr Large Numbers
[ Save ][ Cancel ] [ Of Images
- Editing
@ © The [Setting] checkbox will be checkmarked if the image has the ‘]'TrE%ESF 2
Digital Lens Optimizer already applied. Remove the checkmark —
and click the [Save] button to cancel the Digital Lens Optimizer.
Images displayed in the [Digital Lens Optimizer] window are with Reference
[Sharpness] and [Unsharp mask] effects applied by default. If you
checkmark the [Do not sharpen previews] checkbox, images are T —
displayed without [Sharpness] or [Unsharp mask] effects applied,
allowing you to check only the Digital Lens Optimizer effect. Index
When applying the Digital Lens Optimizer, the effect of

[Sharpness] or [Unsharp mask] may become excessive. It is
recommended that you set [Sharpness] or [Strength] for [Unsharp
mask] for images to 0 before using the Digital Lens Optimizer.
Adjust [Sharpness] or [Unsharp mask] again after applying the
Digital Lens Optimizer to images.
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Performing Automatic Dust Erasure Processing= |
When the list box for selecting an extender is displayed, select The Dust Delete Data that is appended to images shot with the camera
the extender attached at the time of shooting from the list box. that can attach this data, can be used to automatically erase dust spots.
Use the slider to adjust the Digital Lens Optimizer effect. COITTET TS ET
When [MAX] is displayed for the Digital Lens Optimizer level, the . a Glance
effect will remain the same even if you move the slider further to Com patl ble Cameras
the right.
i it i Basic
You can change the dlsplay_posmon o_f _the_check wm_dow by EOS-1D X EOS-1D C EOS-1D Mark IV S0
dragging the enlargement display position in the navigator
window. EOS-1Ds Mark lli EOS-1D Mark llI EOS 5D Mark Il
Even if you set shooting distance for a lens in this window, the EOS 5D Mark I EOS 6D EOS 7D AN
value indicated for shooting distance in the [Lens aberration Operation
correction] window will not change. EOS 70D EOS 60D EOS 50D
If no shooting distance information is saved to the image, the EOS 40D EOS REBEL EOS REBEL
shooting distance slider is set automatically to the right end at T5i/700D SL1/100D Imgg\;i:ﬁ?ng
infinity position and a [<!>] appears above the shooting distance EOS REBEL EOS REBEL EOS REBEL and Pfinting
slider. The distance cannot be minutely adjusted by using the T4i/650D T3i/600D T2i/550D
slider for images shot with an EF-M lens. (The slider is not Processin
displayed.) EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL Large Numbgrs
Images cannot be corrected for [Chromatic aberration] in [Lens L G Y XSi/450D XTI/400D DIGITAL of Images
aberration correction] if the Digital Lens Optimizer has been EOS REBEL EOS DIGITAL REBEL EOS M
applied. T3/1100D XS/1000D Editing
JPEGI/TIFF
i . . . . Images
Click the [Save] button. In the main window, select an image appended with J
Dust Delete Data.
"t - l e Click the [Stamp] button. Reference
= |
The [Digital Lens Optimizer] window closes and correction - — D 4 ; Index
[Dig ptimizer] y ® & @& 2

results are applied to the image in the edit window.

Corrections made in the [Digital Lens Optimizer] window are also
displayed in the tool palette.

In the main window, the [%] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.128).

After clicking the [Save] button, the application of the corrections
to the image may take some time.

The size of the image file will be larger after applying the Digital
Lens Optimizer.

Rotste right Quick Stamp  Trimming Batch
«check process

Rating

The copy stamp window appears.

00
©
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When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

[Set b L00% view 16 perfiem stamg eperation

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [3] mark (p.128) is displayed on an image from which dust
spots have been erased.

? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.75) or the copy stamp function (p.77).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).
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-@> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.142.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.

Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

I
vy ®

S & @

Rotate right Quick Stamp Trimming Batch
check

—

+ The copy stamp window appears.

3 When the image has redrawn itself, double-click the
point from where dust is to be erased.

: Double-
R click

[Set b L00% view 16 perfiem stamg eperation

The display changes to 100% view.
The display position can be changed by dragging.
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Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [[@*O]] button, and if
the dust spot is light in color, click the [[C»C]] button.
When you move the cursor over the image, the dust erasure
range appears as [Q].
Place the dust spot to be erased within the [O] and

click.

() = Click

it the dark 1pet b repeie

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [ £ ] mark (p.128) is displayed on an image from which dust
spots have been erased.

? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.77).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).
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Introduction

W< Useful functions of the copy stamp window Erasing Unwanted Parts of an Image (Copy Stamp Function)

Checking the dust erased spots You can correct an image by pasting a section copied from another part e g

After step 5, you can display and check in detail the erased dust spots of the image to an unwanted part of the image. a Glance

one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +

<B> keys to return to the previous dust spot.) Follow steps 1to 3in “Manually Erasing Dust (Repair _

Canceling a specified erased dust spot only Function)” (p.75). OpBearlgltfon

After step 5, you can press the <Shift> + <F> keys or the <Shift> +

<B> keys to display the erased dust spot, and then press the <Shift> Specify the section to be copied.

+ <Del> keys to cancel only the erased dust spot displayed. Click on the section that is to be the copy source while holding Advanced

Switch between full screen display/normal screen display using down the <Alt> key. Operation

shortcut keys To change the section that is to be the copy source, perform the

You can also switch between full screen display/normal screen operation above again.

display by pressing the <Alt> + <Enter> keys. To fix the position of the copy source, checkmark [Fix Copy |m§‘33§ﬁ?ng

Applying the dust erasure result to another image Source position]. and Pfinting

You can apply dust erasure to the same place in another image by

clicking the [Copy] button to copy the dust erasure results and then Cor_reCt the image. _ _ Processing
displaying the other image to which you want to apply the results and Click or drag on the section you want to correct on the image. [+]  |Large Numbers
clicking the [Paste] button. in the window indicates the copy source and [Q] indicates the of Images
To apply dust erasure to the same place in several other images, you copy destination.
can efficiently erase dust spots by clicking the images while holding The copied image is pasted in the position to which it was Editing
down the <Ctrl> key in the main window, or, by selecting multiple dragged. JT&S/L'SFF
images by clicking the first image and then clicking the last image For [Pen type], you can select from [Brush] (the pasted image’s 2
while holding down the <Shift> key, and then displaying the copy borders simulate a brush) and [Pencil] (the pasted image’s
stamp window. borders are sharp). Reference
Click the [OK] button to return to the main window.
® For images shot with ISO speed range expansion set, noticeable The [ &1 mark (p.128) is displayed on a corrected image.
noise may make it difficult to view dust spots in the copy stamp Index
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.142. @ @
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Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
atime, see p.102.

|§| Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.145) is added. The ICC profile
contains information about [Preferences] (p.94) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

For CS4 or later versions of Photoshop, this function is not
available if a 32-bit version is not installed.

Setting Work Color Space

A different work color space (p.146) from the default settings (p.94) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and then
subsequently change the default color space setting (p.94), this default
setting will not be applied and the individually set color space will remain.

-:@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.

Compositing Images
You can combine two images into a single image. You can further

combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.

The color space of a composited image will be the color space of
the background image.

Image information is not appended to a composited image.

Select a background image in the main window.

e oy e s e [ — [ ——

You can also select a background image from the edit window,
edit image window, or [Collection] window.
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Select the [Tools] menu » [Start Compositing tool].

Tools

Start Quick check tool Alt+Q
Start Trimming/Angle Adjustment tool Alt+C
Start Stamp tool Alt+5
[Start Compaositing tool Alt+X ]

Start HDR tool Alt+Y
Start Rename tool Alt+R
Start EOS Utility Alt+0
Sync folder with EQS Utility

Transfer to Photoshop Alt+P
Preferences... Ctrl+ K

The compositing tool window appears.

Foregound Tinage

Select an mage

|| Fer image comprsiting, select an image ta combine.

Select the image to combine.

Select the image to combine from the [Foreground Image] list
box.

100% view ]

Fareground Image

|1MG_poot.CRZ -

Select an image
IMG 0001.CR2

IMiG 0002, CRE
IMG_D004,CRE
IMG_D006,CR2

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and foreground

image is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window
([Folder] window) or edit window: image in same folder as
background image

* When a background image is selected in the [Collection]
window: image in the [Collection] window

* When a background image is selected in the edit image
window: image displayed in the thumbnail display area

You can combine images of differing sizes.
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Select a compositing method.

Select a compositing method from the [Composite Method] list
box.

[ 100% view |

Foreground Image

MG _nooz.cr2 -|

Composite Method
|add - |
I Add
.ﬁ.veraEE
Lighten
Darken

Position

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.82).

If you select [Weighted], you can set the proportion of brightness
of the image to be combined. Use the [Weight] slider at the
bottom of the [Composite Method] list box or directly enter a
value to set the brightness proportionally.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Introduction

Position the images.

—_—

£AUsers\CANON Pictur o oAIMG_D0OLCRD [34

( Contents at

a Glance
Foreground Image
Basic
Operation
Advanced
Composite Method Operation

Weighted -

[¥] Compose in RAW Format

Weight 50.0 5

. : Advapced
Positon — Shift large amount (50 pixels) |mac? t|_t|ng
an nting

Shift small amount (1 pixel)

L Processing
Allgn Image centers Large Numbers
] o of Images
You can also directly enter the position —
coordinates of the [Foreground Image] .
P Editing
to align it JPEGITIFF
Images
_ Reference
By default, the background image and the [Foreground Image] are
displayed with their centers aligned. —
[Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary. Index
@ You can set [Compose in RAW Format] under the following @ The following functions are not available for images composited S
conditions. with [Compose in RAW Format].
Both the background image and [Foreground Image] are RAW « Auto Lighting Optimizer (p.61) @ @
images, and, all the following conditions are met. « Picture Style Auto (automatically set to Standard) (p.59)
* The cameras used to shoot were of the same model « Selecting [Circle] for the aspect ratio when trimming (p.39) g.\
* The ISO speed setting at time of shooting was the same Q‘

* The highlight tone priority setting at time of shooting was the same
» The image sizes (original size) are the same
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Click the [Save As] button.

2]
=
RN ENICY
=]
£2
[ Congnue ]
[ Save As... D

By clicking the [Save As] button, the [Convert and save] window
(p.42) appears. Specify the required settings, and then click the
[Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The brightnesses of the background image and [Foreground Image]
are added and images are overlaid.

Average

Images are overlaid with negative exposure compensation being
applied automatically. If you want to change the amount of exposure
for individual images, select [Weighted].

Weighted

Compositing method where brightness is set proportionally for the
[Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions being combined.

Darken

The background image and the [Foreground Image] are compared,
with only darker portions being combined.

Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures of the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.
Image information is not appended to an HDR image.

1 Select an image in the main window.

Tl s

D | st 8 bty Sre dwa e St of g 3 e o et g 1
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Select the [Tools] menu » [Start HDR tool]. Specify the required settings, then click the [Start
Toolsl HDR] button.
Start Quick check tool Alt+Q = )
Start Trimming/Angle Adjustment tool Alt+C : e — Contents at
Start Stamp tool Alt+S a Glance
Start Compositing tool Alt+X —
(Start HDR tool AlY )
Start Rename tool Alt+R Basi(.:
- Operation
Start EOS Utility Alt+0
Sync folder with EOS Utility
Transfer to Photoshop Alt+P
IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2 Ad Van Ced
Preferences... Ctrl+K | | Opel’ation
.
The [Select Images] window appears. —
. . . Auto Align
You can also display the [Select Images] window from the edit N :
window and edit image window. __ S — s |mag\(3?ﬁing
and PPinting

@ To change the selected image, or add another image, click the
[Browse] button and in the [Open] dialog box that appears, select

Processing

the image file and click the [Open] button. Large Numbers
® If you select two images of the same size, you can checkmark of Images
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive Editing
patterns (lattice, stripes, etc.) or flat, single-tone images. JPEG/TIFF
By clicking the [Start HDR] button, the [Adjust Image] window &
appears.
® After using auto image alignment, the periphery of the images is GEECIEC
partially deleted. —
Index
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Introduction

Make required selections to adjust the image. [Detail Enhancement]
‘ [Strength]: Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
Contents at
. stronger effect. a Glance
eranes:(59) [Smoothness]: Adjusts the overall smoothness of the image. —
m(,” Move the slider to the right for a smooth and ]
0 natural impression. Basic
Content(50) ) ) . ) Operation
0 [Fineness]:  Adjusts the clearness of details. Move the slider
betaf Evhancenere to the right for a sharper outline.
Strength:{0)
0 Advanced
i [Presets] and finishing effects Operation
il With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by AdvERced
default), instead of operating the sliders individually. By selecting |mag\(3ii_ting
a finishing effect, each slider moves according to the setting. You and Pfinting
7 can also operate and adjust the sliders after selecting an effect.
R . [Natural]: In high-contrast scenes, rendering in areas Processing
L . Large Numbers
Sliders in [Adjust Image] yvhere highlights or s.hadoyvs are usually cl!pped of Images
[Tone/Color] is corrected, for a finish with reduced highlight S —
[Brightness]: Adjusts the overall brightness of the image. Move (Art standard] gr?d sha(:oyvr(]:hpfrl]ng.. inalike tonality f JPEIEdCIBt;'?PFF
- - ; : rt standard]: Gives a finish with painting-like tonality for an
the slider to the right tp brighten the image, and to impressive image Images
the left to darken the image. o SO . —
[Saturation]: Adjusts the overall color saturation of the image. [Art vivid] For a more V!V!d look than W!th [Art standard].
Move the slider to the right to make the color [Art bold]: For a more vivid quk than with [Art standard], Reference
deeper, and to the left to make the color weaker. that makes the subject pop out.
[Contrast]: Adijusts the overall contrast of the image. Move [Art embossed]: Tones down sharpness more than [Art standard], —
the slider to the right to make contrast stronger for an old-fashioned feel.
and to the left to make contrast weaker. e
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rtin M 1
Sta t g Up ap Ut ty Introduction
Click the [Save As] button. Map Utility is a software that allows you to view images shot on a GPS
function-compatible Canon camera, including the shooting location and
Fineness:(0) route travelled. After installing Map Ultility to your computer, you can
i Contents at
I start it up from DPP. 2 Glance
Select the [Tools] menu » [Start Map Utility].
Map Ultility starts up. Basic
For information about Map Utility, refer to the Map Utility Operation
instructions, or to the Help for Map Utility.
Advanced
Operation
® Do not edit images with DPP and use Map Utility at the same time.
Editing results may not be saved properly.
Advapced
Imag iting
. ) i ) and Pfinting
o Version 1.1.0 or later versions of Map Utility are compatible.
By clicking the [Save As] button, the [Convert and save] (p.42) Map Utility is not included on the EOS DIGITAL Solution Disk. Procecein
window appears. Specify the required settings and click the [Start Map Utility] will not appear in the [Tools] menu if Map Utility || arge a
[Save] button. is not installed to your computer. of Images
N ——
Editing
JPEGI/TIFF
Images
Reference
Index
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print N
together with titles and shooting information, etc. WS To maintain the settings

Introduction

The settings of each tab sheet in step 3 are memorized when the [Apply]
Contents at

Select one image to be printed. button is clicked (excluding the contents of the [Text] tab sheet). The Bl e
settings can be applied to another image when printing.
Select the [File] menu » [Print with detailed setting]. ]
|§| You can set printer profiles (p.94). Opearlzltfon
click the [Print] button. colors (p-94). .
Switches the settings tab sheet op‘;";‘;‘t‘i’gn

nase | T st
printer Imag\(gjltlng
((Ganen PEUS s - and ting
Media: 297.0mm x 210.0mm 1
" -] Processing
__ Large Numbers
Media crlenhitun‘ ) of I m ag es
@) Portrait @ Landscape e
Media type:
Plain Paper Ed | ti n g
Print Quality: \] PEG/TIFF
Standard Images
Borderless: ——
Off
Print profile: Reference
CMYK profile: —_—
I (o ) o ) [y Index
I ——— . —_—

Print preview

The image can be moved by dragging. @ @

Drag the four corners of the image to change the size.
For the shooting information, click [[I]] on the [Text] tab sheet @
and select the necessary items in the window that is displayed.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper. sy

Introduction

Select images to be printed in a thumbnail list.

button is clicked (excluding the contents of the [Text] tab sheet). The a Glance
Select the [File] menu » [Contact Sheet Prints]. settings can be applied to another image when printing. —
. . - o _ _ Basic
Specify the required settings for printing, and then 5/ You can set printer profiles (p.94). R
click the [Print] button If CMYK simulation has been set, the image is printed in the set -
' . . colors (p.94).
Switches the settings tab sheet Advanced
Operation

P””‘P" Image | Text | Settings

Printer:
[ Ganon PRAUS oo -

Media: 210.0mm x 297.0mm
Ad 'l

Media orientation:

(@ Portrait () Landscape

Media type:
Plain Paper

Print Quality:
Standard

Borderless:
off

Print profile:
CMYK profile:

CMS settings...

N
Print J

[

Cancel ][ Apply ]

Print preview

> To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]

—_—
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro and Print Studio Pro, you can print with
DPP by a simple operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP and Easy-PhotoPrint Pro, first install Easy-PhotoPrint
Pro version 1.3 or later on your computer.

Printing with DPP and Easy-PhotoPrint Pro
Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].

Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.94) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.146), and try printing.

/

> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.78, p.94), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with DPP and Print Studio Pro
Select the [File] menu » [Plug-in printing] » [Print
with Print Studio Pro].

Print Studio Pro starts up.

Specify required settings for printing photographs,
and then print.

Refer to Print Studio Pro's Instruction Manual for details on
settings.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.96) is not applied.

Y

@< Advantages of printing with Print Studio Pro

Printing with faithful colors
When a color space is set (p.78, p.94), it is automatically transmitted

from DPP to Print Studio Pro, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required printing photographs and then
print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.91) and CMYK simulation (p.94) are not
applied.

Vs

@< Advantages of printing with imagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.78, p.94), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.

Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Tools] menu » [Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences

General settings | View settings I Tool palette I Color management |

Startup folder
@ Last displayed folder
(") Specified folder

Browse... L

Save redpe

@ Display message when adding file

) Add to file automatically

Viewing and saving RAW images

Viewfsave RAW images at high quality

@) High quality (recommended!
I ! Maire is reduced and the NR tool palette can be used

View images at high speed (moire reduction
Mo
_ High speed

JPEG image quality

[~ Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup
[ Edit image window enabled at EOS Utility startup

l[ OK ] [ Cancel ]
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General Settings

You can specify the folder that opens when DPP is started up, image
quality of displayed and saved RAW images, etc.

Preferences

General settings | View settings I Tool palette I Color management |

Startup folder
@ Last displayed folder
~ Spedified folder

Save recpe
@) Display message when adding fille

) Add to file automatically

Viewing and saving RAW images

View/save RAW images at high quality

@ High quality {recommended)
Moire is reduced and the NR tool palette can be used

View images at high speed {maire reduction
D Ufﬂ
_ High speed

JPEG image quality

[F1Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup
[ Edit image window enabled at EOS Utility startup

Ok ] I Cancel I

Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display speed
of a RAW image in the edit window or the edit image window, and the
time it takes to save a RAW image is shorter than with [High quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

® For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.
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) ) Introduction
JPEG image quality View Settings
[Remove block noise and mosquito noise] . . . .
: h litv of . b ina th : You can specify settings relating to the display.
You_can improve the quality of a JPEG image by reducing the noise Contents at
particular to JPEG images. a Glance
This setting is also effective when RAW images are converted to —
JPEG images and saved (p.42, p.101) and for JPEG images that General settings View settings Tecl palette [ color management
have been saved with a different name. e Basic
64 Pixels(3-258) Op eration
D ————————————
? The extent of the improvement in noise reduction Image selection status
[¥]1mages opened in Edit window remain selected in main window
The higher the JPEG image’s compression rate, the more noise is éd‘é";‘gt(i’gﬁ
reduced. When the compression rate is low, the effect of noise reduction Magnification in Edit window p
iS negllglble @) Fit to window ) 50% ) 100% () 200%
Magnification when the Edit/Edit image window is double-dlicked I t
. § _ : mal 1tn
Default value of output resolution O %% s e ano? t,ngg
You can set the resolution for RAW images converted and saved as RAW ard PPEG
JPEG or TIFF |mages (p42, plol) ["|Displzy enly CR2 images for CR2 and JPEG files of the same name: ProceSSIng
Large Numbers
Sort order in main window of |mages
[ Retain sort order —
Highlight/shadow Alert Ed | tl n g
| JPEGI/TIFF
Highlight 255 (192-255) . Im ages
Shadow 0 (0-64) . ——
Quick check tool display
@ 50% () 100% (moiré reduction off) Referen ce
—
[ 0K ] [ Cancel
Index
—_—
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Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you exit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you exit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).

Tool Palette

You can specify settings for the tool palette.

General settings I View settings

| Tool palette

Default settings of RGE tool palette
Tone curve mode
@ RGERGB
() Luminance R G B
Histogram display
() Before adjustment

®) After adjustment

Tool palette display in Edit Image Window
(@ Docking display

() Floating display

Modified Picture Style settings
Retain settings of each Picture Style

Tool palette display mode
[ 5ame for Main window and Edit window

Default noise reduction settings
@ Apply camera settings
() Set as defaults

R Jurira

TIFF/IPEG luminance noise reduction:(0)

TIFF/IPEG chrominance noise reduction:(0)

Tone curve interpolation method
@ Curve

(©) straight

Color management

__Cance\

Default settings of RGB tool palette

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.
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Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed accordingly or
retained, when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

== Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high 1ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

i Color management L

General settings | View settings | Tool palette ‘

Default settings of Wark color space
@) sRGE () Apple RGE
) Adobe RGB _) ColorMatch RGB

) Wide Gamut RGB

Color matching settings
For display

@) sRGE
Use the OS settings
) Monitor profile

Browill

Printing profile

Perceptusl

= None — -
| @) Relative Colorimetric

CMYK simulation profile

perceptual
— None — -

| ) Relative Colorimetric

Rendering intents when using Easy-PhotoPrint
*) Perceptual

I ® Relative Colorimetric
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Default settings of Work color space

You can select from five types of color space (p.146) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.101) or printed (p.43, p.46, p.49, p.86 to p.90).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.126, p.127), the edit window (p.129), and the edit image
window (p.135).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.78).

Display setting (color setting of the monitor)

Where a profile (p.145) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP.
If you are using multiple monitors, only the profile of the primary
monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

=@ Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Setting of printing profile (color setting of the printer)

Where a profile (p.145) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.86, p.87) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.88, p.90).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

:@3 Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.88, p.90), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.
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Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.146) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.126, p.127,
p.129, p.135) at the bottom of the main window, edit window and edit
image window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.146) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

e e

RAW |ReB | nR/ALO [ LENS |

7

| Brightness adjustment
) 0.00
|Whibe balance adjustment @ |
1 2 3 Register...
Iﬁ (Auto) - | Tune...
|| Picture Style
[ﬁ (standard)

- | Browse...

-10.0 8.0 5.0 40 -20 00 20 40

Contrast: {0) {1

Highlight: (0) i

Shadow: {0} {1

D Linear

Color tone: (0} I

Color saturation: (0) i}

[Unsharp mask v]
Strength: (D) [
Fineness: (0} [

Threshold:(0) 1

[—

3& R rﬁage data

—
vrd)

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.vrd").

|§| The adjustment contents of JPEG or TIFF images (p.105) can be
saved as a recipe file (extension “.vrd”) and loaded and applied to
another image in the same way as with RAW images.

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB], [NR/ALO] and [LENS]). For this reason, other editing content
such as trimming or dust-erasure (copy stamp) is not included in the
recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu P [Save recipe in file].
The [Save recipe in file] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. S
The recipe is copied.
? Check the contents of arecipe file by pasting to an image Select the image to Whi_Ch the recipe is to b? applied /Sg‘é?gﬁgﬁ
o _ _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
ST : selected image].

and check the settings in the tool palette. When only a few settings are " _ _ Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which arecipe is to be copied

a Glance

Proceflsing
Largbers
of Im@ges
Loading and Pasting Recipes -
iting
Select the image to which arecipe is to be applied, JPEG/TIFF
. Images
and then select the [Edit] menu » [Read and paste
recipe from file].
The [Open] dialog box appears. Reference
Select arecipe and click the [Open] button.
The recipe is applied to the image.
Index
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance

Adjust the white balance (p.28, p.56).
To adjust white balance, select a setting other than [ & ()] from
the [White balance adjustment] list box (p.28). You will be unable
to register the adjustments if you select [ & ()].

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white am:‘

Register current setting in personal white balance

Current setting: Click white balance

? To use the registered personal white balance on another
computer

In step 3, click the [Export] button to write as a file.

Copy the file to another computer.

In DPP on the other computer, display the window of step 3.

Click the [Import] button and in the window that appears, select the
copied file.

® You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.

Applying Personal White Balance
In the main window, select the image to which white

balance is to be applied.

Click the [Tool Palette] button on the toolbar.

The tool palette appears.

Click the personal white balance number button that

IS to be applied.

RAW |RGB |MR/ALO | LENS |
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160 (@2GE) e

| Daviight [ Ture...

| Picture Style =]

[ﬁ (Standard) vl Browse...

-10.0 8.0 60 <40 -20 0.0 20 4
Contrast: () {1
Highlight:{0) 1
Shadow:(0) {

|:|Linear
]
I

Caolor tone: (0}

Color saturation: (0)

[Unsharp mask vl
Strength: () [
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar (p.126).

The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings

IMG_0001.CR2 Save folder
Browse...

MG_0002.CR2
IMG_0003.CR2 E:\Users\CANON Pictures
MG_0004.CR2
IMG_0005.CR2 File format
MG_0006.CR2
IMG_0007.CR2 find of file
MG_0008.CR2
IMG_0008.CR2
MG_0D10.CR2
IMG_0011.CR2
MG_0D12.CR2 Qutput setting
IMG_0013.CR2
MG_0D14.CR2 Output resolution 350 dpi  [¥]Embed ICC profie
MG_0015.CR2

Exif-JPEG M

Image quality 1 10

@) New file name
String Sequence number
DPP_ 0001
Save sequence number

Ex.: DPP_0001.JPG, DPP_0002.JPG...

Image transfer settings

Open image using software

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.121) to edited RAW images.

E@:— To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

-Z@/E Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

® If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

|§| If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.113) or dust-erased image (p.73 to p.77, p.116 to p.120)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, see p.143.

R

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing

and Printing

Procefésing
Larg bers
of Im@ges

Editing
JPEGI/TIFF
Images

Reference

Index

00

101



Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.78), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after exiting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar (p.126).

The [Batch settings] window appears.

Perform settings required for transferring (e.qg. file
format).

Click the [Browse] button.

Batch settings
IMG_0001.CR2 Save folder
IMG_0002.CR2
IMG_0003.CR2 E:\Users\CANON Pictures
IMG_0004.CR2
IMG_0005.CR2 File format
IMG_00D5.CR2
IMG_00D7.CR2 Kind of file Exif-IPEG -
IMG_00D8.CR2
IMG_0009.CR2 ]

. 10
IMG_0010.CR2 Tar=am s 0
IMG_0011.CR2
IMG_0012.CR2 Output setting
IMG_0013.CR2
IMG_0014.CR2 Output resolution 350 dpi Embed ICC profie
IMG_0015.CR2

Resize setting
|| Resize
pivel
Lock aspect rat
File nam
~) Curren it file name
@ New file name
String Sequence number
DPP_ 0001
[] save sequence number
Ex.: DFP_0001.JPG, DPP_000Z.JFG...
Image transfer settings
Open image using software
Execute Cancel

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

Dpen image using software

E:Program Files\Adobe\Adobe Photoshop CS\Photoshop Browse. ..

[ Execute ] [ Cancel ]

e w3 =

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.

® If the message [Insufficient memory.] appears, too many images are

selected at the same time. Decrease the number of selected
images.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Introduction

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can Contents at
change in one operation the names of the files for the images, in the a Glance
order they were rearranged.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings (p.144) and click the
[Execute] button.

@ i I -==]

File name Extension

Change the order of the images in the main window Basic
(0.21). Operation

In the main window, select multiple images of which

[~ Copy and Rename

E:\Users\CANONPictures

Insert underbar

DPP w Shooting Date/Time « Sequence number - R Ad Van C Ed
S— Format ettngs the file names are to be changed. Operation
Sort Sequence number
S T e Sl Select the [Tools] menu » [Start Rename tool].
5 Shootng DateTme Sh[y”:";f;“’y J Advanced
Same file name for RAW +IPEG images - L . . | m ag e Ed |t| n g
[mas00 ] Select [Fit to main window]. and Printing

(@) E\Users\CANON\Pictures\Photoooos 1ot 100

Criginal File Name Modified File Name Fz A Pro C SI n g
IMG_D001.CR2 DPP_06-03-13_0001.CR2 Larg bers
IMG_0001.1PG DPP_06-03-13_0001.3PG DFP w  Shooting Date/Time of Im ges
IMG_0002.CR2 DPP_06-09-13_0002.CR2
IMG_0002.1PG DPP_06-09-13_0002.JPG . N
IMG_0003.CR2 DPP_06-08-13_0003,CR2 Basic Settings
IMG_0003.1PG * DPP_06-09-13_0003.IPG o,
IMG_0004.CR2 DPP_05-09-12_0004.CR2 Sort Ed 1tn g
IMG_0004.1PG DPP_06-03-12_0004.1PG

( @) Fit to main window J JPEG/TIFF
- Images
_I File name
[ [ Beate ] Cancel | ") Shooting DateTime
Specify the required settings (p.144). Reference

Processing begins and the file names are changed. _
To copy an image, checkmark [Copy Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is Index
maintained. R

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file name
has been duplicated. Changes cannot be made if even one file name has
been duplicated. Change the settings so that duplication does not occur.

@ The name of the movie files cannot be changed in DPP. @ @

|§| You cannot start up the rename tool from the [Collection] window @

(p.36, 9'127)' _ _ ® If the message [Insufficient memory.] appears, too many images are
For a list of the rename window functions, see p.144.

selected at the same time. Decrease the number of selected

images.
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5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it —
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgﬁinr;cgeat
Editing JPEG and TIFF Images...........cevvvvvvneennee. 105 ]

About the RGB Tool Palette .............cccocoeeeeeenenn 105 B

Automatically Adjusting Brightness and Color (Tone S

Curve ASSISt) ...ooooiiiiiii, 106

Adjusting Brightness and Contrast ...............c.co...... 107 gg‘é?;‘t‘i’gﬁ

Adjusting Color Tone Using Click White Balance..... 108

Adjusting Hue, Saturation and Sharpness................ 109

Tone Curve AdUSIMENt...........ccvovvreeeeeeieeereneneeens 110  [image diting

Adjusting Dynamic RanNge ........cccccceevvvviicnvviiieeeeennnn. 111 and Printing
Reducing NOISE .........ovviiiiiiiiie e 112 :

. . . . Processing
Trimming and Adjusting the Angle of an Image..... 113  |Large Numbers
Performing Automatic Dust Erasure Processing ... 116 .2 mages |

Compatible Cameras...........ccoeeviviiiieiiieciieecee, 116 —

Automatic Dust Erasure Processing in the Main JPESH:F

WINAOW ... 117 i .qefe
Manually Erasing Dust (Repair Function).............. 118

Erasing Unwanted Parts of an Image (Copy Stamp Reference

FUNCHION). .. 120
Compositing and High Dynamic Range................. 120
Starting Up Map ULty .......cooeeeieiiiiiiieeeen 120 Index
Saving Editing Results.........ccoviiiiiiiiin 121 S

Saving Editing Content to an Image............ccc...u...... 121

Saving as a Separate IMage .........ccoveveeeveeeveerennn. 121 @ @
Applying Editing Contents to Another Image......... 121
PrNtING ..o 121 @
Re-Editing an Image...........cooevviiiiiiiiiiiineeeeeeeeeeee, 122
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/ALO] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

[raw |ReE  [nmjaLo [ ens |

Tane curve assist

)
Tone curve adjustment
(il (=) (<)

255

b MR Ts

G,‘TIFF' |mége

P A I \\

Thy

Lurd

Brightness: i 1] ——

Contrast: i o | Contents adjusted using the tool
e 0 o palette can be handled

el _ 0 i individually as a recipe file
et 0 & || (extension “.vrd”) (p.98, p.121).

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.121), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.98, p.121).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.110) and
automatic adjustment (p.106), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.145). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

Use when the effect achieved in standard automatic

images.
High:

adjustment is not strong enough.
RAW | RGB  |NR/ALO | LENS |

‘Tone curve assist

il 3 =) Reverts the tone curve

|Tone curve adjustment

to the original settings

Crss  JRI[s][E]

255

High

Standard

Brightness:

Contrast:

Hue:
Saturation:

Sharpness:

[ ®]o
{1 [B] w00
[ ®]o

The tone curve changes as adjusted.

=@~ Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

¢ Images which are too dark

* Images which have extreme backlighting

® If you click the [[[Z%]] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.109).
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Introduction

- - - Brightness: Move the slider to the right to make an image
Adj usti (16 B (U htness and Contrast brighter and to the left to make an image darker.

The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance
RAW | RGE  |NR/ALO [ LENS | contrast of an image stronger and to the left to

|Tone curve assist | make contrast weaker. -
asic
‘Tone curve adjustment ‘ Operation

|

|

Lokee.  J[r][c][e]

|

Advanced
Operation

|

Advanced
Image Editing
and Printing

|

Processing
Large Numbers
of Images

E g
Drag the sliders left or JP [o=
Brightness: : 'Di o rlgh? Irﬁs

Contrast: - ( | 0 Enter numerical values

Hue: : (I [®]o Reference

|

|

Saturation: : D 100
Sharpness: [} @ i

Index

00
©
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|§| The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the

standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[.2]] button.

RAW | RGB  |NR/ALO | LENS |

| Tone curve assist |

‘Tone curve adjustment =3
Lok JR]

255

Brightness: ; [ i
Contrast: ; D a
Hue: ; D @ a
Saturation: 100
Sharpness: [} @ i

Click on a point that is to be the standard for white.

T
Em——

The coordinates of the cursor position and
the RGB values (8-bit conversion)

=» The color of the image is adjusted with the point you selected as

the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[# ]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.93).
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Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall
atmosphere of an image sharper or softer.

RAW | RGB  |NR/ALO | LENS |

|Tone curve assist

() (iz+) iz

‘Tone curve adjustment

=]

Lokee.  J[r][c][e]

Brightness:

Contrast:

Hue:

Saturation:

Sharpness: m

Bo

100

Bo ]

Enter numerical values

Drag the sliders left or right

Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones
redder.

Saturation: Move the slider to the right to make the color

deeper, and to the left to make the color weaker.

Sharpness: Move the slider to the right to make an image
sharper, and to the left to make an image softer.

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Introduction

Tone Curve Adjustment Make adjustments. S
You can adjust the brightness, contrast and color of a specific area by RAW | RGE  [NR/ALO | LENS |
changing the tone curve (p.145). [Tone curve assist ([0 ([)[2s)] Conients at
- a Glance
‘Tone curve adjustment E”
Select the tone curve mode and interpolation R, J(r (][5
method. 255 Adjusts each channel Basic
Batch adjusts RGB Clpeggier
RAW | RGB  |NR/ALO | LENS | —
‘Tone curve assist |
|Tone curve adjustment | édvant(':ed
peration
&)(c) Click to add a [] (point) L |
22 Adjust by dragging [J]
Advanced
Image Editing
and Printing
—
Curve A
. . . Processing
Straight Right-click with the Large Numbers
mouse inside the graph of Images
l ‘ Rhibos to display the menu Brightness: ' { 0 R
Luminance RG B
— Contrast: : ] 0 E g
LY IPEGWIFF
; e ) 0 | es
' ue: @ a
a
Saturation: ] 100
0 Jee aturaton [E]
e _ 0 5 Sharpness: [ (B] o Reference
Contrast: - I 0 The horizontal axis shows the input level and the vertical axis
0 shows the output level.
Pl ’ The maximum number of [[]] is 8. Index
SR U 100 To delete a [[]], either press the <Del> key or double-click on the [[(J]. “—r’
Sharpness: [ i

|§| The histogram display changes according to adjustment. You can @ @
also fix the histogram display to the display before any @
adjustments (p.93).
The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.93).
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Introduction
Adjusting Dynamic Range 5 © The setting range of shadow points is 0 to 247 (in 1-stop —
Dynamic range (width of gradation expression) from dark points to bright increments when entering a value).
ynam 9 grad P b 9 The setting range of highlight points is 8 to 255 (in 1-stop Contents at
points in an image can be adjusted. . -
increments when entering a value). a Glance
The histogram display changes according to adjustment. You can —
Move downwards also fix the histogram display to the display before any _
Output highlight points adjustments (p.93). Basic
Operation
RAW | RGB  |NR/ALO | LENS | N
|Tone curve assist |
‘Tone curve adjustment ‘— Reverts the Advan(_:ed
—rw—(rAl —#1|| image to the Operation
Output 255 original S —
hlghllght point settings Advanced
numerical Image Editing
value and Printing
—
Processing
Move to the Move to the Large Numbers
right left of Images
Input shadow Input highlight
points points = g
JP IFF
I es
Output shadow
pointnumerical 2551+ Input highlight
value epi— 0 5 point numerical Reference
value S
Contrast: a
Input shadow
point numerical ®) 0 Index
value k _J
Saturation: D 100

Sharpness: [} @ i

Move upwards @ @
Output shadow points @

The horizontal axis shows the input level and the vertical axis shows
the output level.
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You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

RedUCIng NOISe Introduction
You can reduce noise that arises in JPEG and TIFF images that have Click the [Apply] button.
been shot at night or with a high ISO speed. Noise reduction is applied to the image and the image is
] redisplayed.
Select the [NR/ALO] tab sheet from the tool palette in Contents at
the edit window or edit image window.
Click the [NR Preview] button. Basic
Operation
|Nnise reduction Apply |
[[ MR. Preview... ]
s Advanced
The [NR Preview] window appears. ok
Adjust an image. JyT—
NR Preview Image Editing
I and Printing
Navigator
window - Processing
@< To set the same noise reduction level for several images ERIGe NUNIDEES
— Enlargement of Images
display After selecting multiple images in the main window, you can set the
TIFEpEG _ position same noise reduction level for the images without displaying the [NR E g
et oo . Preview] window, by adjusting the noise reduction level in the [NR/ALO] JPEGIFF
Drag the . : : . Imefes
ronarcerosThguon®) sliders tool palette (p.131) using the [Luminance noise reduction] and
i @) = [Chrominance noise reduction] sliders, and then clicking the [Apply]
I button.
NR check window Reference
You can set a noisg reduction level from_ within a range of 0 to 20. |§| If [Luminance noise reduction] has been set, resolution may be
The larger the setting, the larger the noise reduction effect. reduced along with reduction of noise.
The noise reduction effect can be checked when an image is If [Chrominance noise reduction] has been set, color bleeding Index
displayed at 100% in the NR check window. may occur along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.93). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.

For a list of [NR Preview] window functions, see p.133.
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the

composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range

will only be masked in black and the image will not be trimmed.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

I
y ® & & 2

Rotate right Quick Stamp Trimming Batch
check Angle process

Rating & & » & &

The trimming/angle adjustment window appears.

Editing can be done once the image is displayed clearly in the

trimming/angle adjustment window.

Adjust the angle of the image as needed.
Trimming/angle adjustment window

== | argest
possible
trimming
range

v o }— Click (rotate

— image left
or right in
- 90-degree
o increments)

Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.
If you click [Center on Screen], you can display the trimming
range in the center of the window.
If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 70D, EOS
60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL
T4i/650D, EOS REBEL T3i/600D or EOS M, the trimming range
based on the aspect ratio information is displayed.
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{704, 362) > (228, 1413) = (1577 £ 1051) [ 1.50)

Select aratio and drag the trimming range.

i) e

= (C=_)}— Cancel

: y— Select a
trimming
e ratio

—— Drag the
trimming
range

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

1:1
32
213
43
34

5:4

4.5

A Size Landscape
A Size Porfrait
Letter Landscape

Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.128).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.122).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.128).

* Edit window:

 Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.121).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark 1ll, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 70D, EOS 60D,
EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, the set trimming range
based on the aspect ratio information is displayed. Since the image is
not actually trimmed, you can change the trimming range or revert to
the condition before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 70D, EOS 60D,
EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, its trimming range cannot be
changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.*
When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.137).

The image is displayed in its trimmed condition.

* For JPEG images shot with EOS 5D Mark IIl and [Add cropping
information] set in Custom Functions, aspect ratio information is
only set and the image is not actually trimmed.

ALy

-@> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see
p.137.
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Performing Automatic Dust Erasure Processing .
The Dust Delete Data that is appended to images shot with the camera When the image has redrawn itself, click the [Apply
that can attach this data, can be used to automatically erase dust spots. Dust Delete Data] button.
= T Cont;ants at
. a Glance
Compatible Cameras
Basic
EOS-1D X EOCS-1D C EOS-1D Mark IV Operation
EOS-1Ds Mark I EOS-1D Mark Il EOS 5D Mark IlI m
EOS 5D Mark II EOS 6D EOS 7D —— Advanced
EOS 70D EOS 60D EOS 50D - ok
EOS 40D EOS REBEL EOS REBEL e
T5i/700D SL1/100D Advanced
Image Editing
EOS REBEL EOS REBEL EOS REBEL and Printing
T4i/650D T3i/600D T2i/550D e S—
EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL » Dust spots are erased in a single operation. L;B%C,Sﬁrﬂggr s
T1i/500D XSi/450D XTi/400D DIGITAL _ o of Images
Click the [OK] button to return to the main window. "
ngllg(l)EDBEL iglslc%g[I)TAL REBEL EOS M ‘ =»The [@,] mark (p.128) is displayed on an image from which dust E g
spots have been erased. Jp’%”:,:
. . . . I es
In the main window, select an image appended with
Dust Delete Data.
Click the [Stamp] button. Reference
I
> > > > > Index
y ® & & 89
Rotzte right Quick Stamp Trimming Eatch
check Angle process
Rating
= 00
—- — @ Dust Delete Data is not attached to images having settings specified @‘
The copy stamp window appears. during RAW processing on the camera for distortion correction, o

chromatic aberration correction, etc. As a result, you cannot perform

automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.122).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.118) or the copy stamp function (p.120).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.121).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.142.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Click the button that matches the dust spots to be

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

I
y ® & @ 2

Rotate right Quick Stamp Trimming Batch
check Angle process

Rating

_——

The copy stamp window appeatrs.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

184 5 156 s

o o : Double-
O click

Set b L00% view 16 perfiem stamg peration

The display changes to 100% view.
The display position can be changed by dragging.

erased.
If the dust spot is dark in color, click the [[@»C ]] button, and if the

dust spot is light in color, click the [+ ] button.
When you move the cursor over the image, the dust erasure

range appears as [O].
Place the dust spot to be erased within the [O] and
click.

W 27 Cvseconpa

(D) == Click

il the dark 1pen ta repair

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [ ] mark (p.128) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.120).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.122).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.121).

A/

-@> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +

<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only
After step 5, you can press the <Shift> + <F> keys or the <Shift> +

<B> keys to display the erased dust spot, and then press the <Shift>

+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using

shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and

clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you

can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.142.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.118).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.128) is displayed on a corrected image.

Compositing and High Dynamic Range
You can composite images also using JPEG and TIFF images in the
same way as RAW images as described below.

Compositing Images (p.78)
Creating HDR (High Dynamic Range) Images (p.82)

Starting Up Map Utility
You can start up Map Utility using the procedure below.
Starting Up Map Utility (p.85)
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Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.105 to p.112)
as well as the trimmed range (p.113) and dust-erasure (p.116 to p.120)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

File
Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save.., Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 4
Add to collection Ctrl+G
Remaove from collection Ctrl+5Shift+G
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+Fd

Your adjustments are saved to the image.

Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.105 to p.112)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.113) or dust-erased image (p.116 to
p.120) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.101)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.98)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.86)

Printing a thumbnail list (contact sheet printing) (p.87)

Printing RAW images on a high-end Canon printer (p.88)
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.105 to p.112), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.113) or dust-erased image (p.116 to
p.120) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.121) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment
Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard
Tone Curve Assist - High

Revert to last saved settings Ctrl+Alt+Z

Revert to shot settings Ctrl+Shift+Z

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) as a user setting. You cannot install the software
if a user setting other than an administrator-level privilege is selected.
For detailed information on selecting an administrator-level privilege,
refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images are not displayed properly

Images that are not supported by DPP are not displayed. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.73 to p.77, p.116 to p.120) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.130).

PowerShot Prol RAW images cannot be adjusted with the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.130).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.126, p.134, p.135),
trimming (p.38, p.113), dust erasure (copy stamp) (p.73to p.77, p.116
to p.120) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.130).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D X, EOS-1D C, EOS-1D Mark 1V,
EOS 5D Mark lll, EOS 5D Mark I, EOS 6D, EOS 7D, EOS 70D, EOS
60D, EOS 50D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D,
EOS REBEL T1i/500D, EOS REBEL T3/1100D and EOS M. You
cannot apply the Auto Lighting Optimizer’s adjustment contents to
RAW images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.78,
p.94) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.94) and a profile for a printer is
set up correctly (p.94), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.88, p.90) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and PowerShot Prol may not display
image information (p.10, p.23).

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Windows 7, Windows Vista, Windows XP

Select the [ @] button ([Start] button in Windows XP)
» [All Programs] » [Canon Utilities] » [Digital Photo
Professional] » [Digital Photo Professional
Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
The software is uninstalled.

Windows 8

Uninstall the software according to the OS software uninstalling
method.
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List of Main Window (Folder Window) Functions .10

Shows/hides the tool palette (p.130) Image information (p.23)

Shows/hides the folder area Selects all images ‘

Switches to the editimage (p.137)
window (p.135) |

Folder path ijitel Phote Professional oo o =)
Fi Edit  Vie| Tools |Window Help
Toolbar*! - 2 d A A 3 N N :

B®® 9
[Collection] tab sheet*> =

Select all Clear al Rotate left Rotste right

Cancels selection of all images
Displays the quick check window (p.134)
Displays the copy stamp window (p.142)

Displays the trimming/
angle adjustment window

Batch conversion/
saving

alette
I“ Folder Collection{a)

[Folder] tab sheet*> (p.101, p.102, p.143)
Bl Desktop 3 i
R fo ) Image rotation
@ i ocuments
- Music (90 degree
BH Pictures B
Check mark (p.19) T o increments)
Sample_Pic_tures
E Videos
[j-:aa. Homegroup .
=3 cavon A — > — Rating (p.19)
2 =48 Computer IMG_000L.CRZ IMG_0002.CR2 IMG_D004.CR2 IMG_0005.CR2
Folder area* -6 Network
IMG_D007.CR2 ~_IMG_0008.CR2 IMG_DOD9.CR2 IMG_0010.CR2
=
IMG_D01L.CR2Z IMG_D012.CR2 _ IMG_0013.CR2 IMG_D014.CR2 meoots.cr2
Image COIor Space sRGB [ Adobe RGB High quality Redpe data: Yes Number of images: 15 Nli.lmbEI’ of selected images: 1 cMYyK ——————————— CMYK SImUIatlon

and work color . display (p.94)

— -
space*3 (p.78, p.95) Number of selected images

|
Display mode**
Recipe attachment status (p.98)

Number of displayed images

*4 The item selected in [Viewing and saving RAW images] (p.91) of the
[Preferences] window is displayed.
*5 You can switch between the [Folder] and [Collection] windows.

*1 To switch between show/hide, select the [View] menu » [Toolbar].

*2 The images inside the folders selected here are displayed in a
thumbnail list on the right.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette.
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List of Main Window (Collection Window) Functions 39

Image information Cancels selection of all images
Shows/hides the tool palette Selects all images ‘
Switches to the edit image

Displays the quick check window

Displays the copy
stamp window

window
(@ o ) [E=rE)
File | Edit View Bookmprk Label Adjustmeni Tools |Window Help
Toolbar ‘I & fa 2 D PP ™ 3 P Batch conversion/
[CO”eCtion] tab Sheet*l - y Info Scectal Clarsl | Rotstelft Rotste ight serr Saving
[Folder] tab sheet _
' Displays the
- trimming/angle
adjustment window
_ Rating
' MG_0002.CRZ ' IMG_0004.CR2 L+ IMG_DD0E|CR2 IMG_0009.CR2 ' IMG_0012.CR2 MG_0013.CR2 .
| Image rotation
(90 degree
increments)
e —— Check mark
B ewnon
\I/U-]O?Eecgloolrorsspaice:fzand sRGB [ Adobe RGB High quality Reclpe_ data: Yes Nymber of images: 7 MNumber of selected images: 1 CMYK CMYK Slm ulatlon
P | display

(p.78, p.95)

Display mode Number of selected images

Recipe attachment status Number of displayed images

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool
palette.

*1 The total number of images added to the [Collection] window is
displayed in the () in the [Collection] tab sheet. Accordingly, when an
image is added that is displayed as a single image (p.22), twice the
total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (.10.p.34)

Information displayed when [Large thumbnail] (p.10) is selected

File Edit View Bookmark Label Adjustment Tools Window Help

. . = e . S = p— a—
2® @B®®H®» ® 5 @

Ei:-,l:;l::?,e FI:;Efr p‘;;ile Info Selectall  Clearall  Rotste lft Rotate right 311:;: Stamp TI:;’EQ -.'.: (D)Igsltl’?.]llzl_eernns’]ark

(p.69 to p.73)

| Folder | Collection(d) | Check mark Rating Yy = o

Deskto
Check mark :ﬁ o Copy stamp mark
(p-181 plg) EIB Documents (p73 to p.77, p.116
i1l Music to p.120)
== Pictures
. 2l Photo —— Lens aberration
5 i - ml‘?‘-;?‘-f‘ b correction mark
EIE Videos i (p65)
-+ Homegroup —— Trimming range**
Rating mark m. 8 CANON (p-38, p.113)
(p.18, p.19) m Lj---;:i- Computer
Bri i€l Network %3
rightness Aperture
adjustment ﬁ | Fis
value*? (p.26) m F ﬂ‘*igﬂtﬂm L IMG_0002.CR2
White balance icon*. File name Unsaved editing content mark GPS mark*®
(p-28) Image type*? Shutter speed*3
*1 Does not display with [Small thumbnail]. *4 When aspect ratio information is attached to an image shot with
*2 Displays in RAW+JPEG images displayed as a single image (p.22). EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
[RAW] is displayed in RAW images. Mark 11, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 70D, EOS 60D,
(In [Small thumbnail] (p.10), [R] is displayed.) EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
In PowerShot Prol RAW images, [RAW] is not displayed. 650D, EOS REBEL T3i/600D or EOS M, the image is displayed as a
*3 Does not display with [Medium thumbnail] or [Small thumbnail]. trimmed image.
*5 Displayed on images shot on a GPS function-compatible Canon
camera.
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J

List of Edit Window Functions ¢.11.p.25 |
Introduction
Path and file name of image Tool palette*! (p.130, p.131, p.132) -
B P - Contents at
File Edit View Label Adjustment Tools Window Help RAW [pee | nR/aLo | Lens | a Glance
( | Brightness adjustment J —
- i 0.00
|White balance adjustment ] B as | C
1](2])(z Register... Operation
[ﬁ (Auta) - |[ Ture... ] \
=== || Advanced
@ (standard) - Bromse.. Operation
o
Advanced
Image Editing
- - and Printing
N —
-10.0 80 -60 40 -20 00 20 40
Contrast:(0) £ 0 q
Highlight: () {1 Processin g
Shadow:(0) 0 Large Numbers
[ Linear of Images
Color tone: {0} {1 —_—
Color saturation:{0) k {1
[Unsharp mask v] Ed|t|ng
Strength:(0) [t JPEG/TIFF
Fineness:(0) [ I m ag es
Threshald: (1) D —_—
Reference
(1155,1638) : 42, 44, 28 RAW / Adobe RGE CMYK High qu;Iity .

Index

Information display*? Display mode**

Image color space*3 and work CMYK simulation display (p.94)
color space (p.78, p.94)

]
00
o

*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.91) of the
bit conversion). [Preferences] window is displayed.
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List of Tool Palette Functions
RAW Tool Palette (p.25)

IMG_D00LCR2 =
RAW | RGB MR/ALC | LENS
ightness adj = | . .
CEE==E— = Brightness adjustment (p.26)
: I} 0.00
White balance adjustment ]ﬁ

1z reost=. | li— White balance adjustment
’@{ﬂuto} vl Tune... (p28’ p56)
|Picthe Style _ )
@ standara) ) ar— Picture Style settings (p.26, p.59)
Dynamic range adjustment (p.57)
-10.I0 -3.0 -6.0 -4.0 -Ziﬂ 0..0 2.I0 4i0 .
Contrastz(0) T Contrast adjustment (p.29)
:f’:'ghté? g Shadow/highlight adjustment (p.57)
[ Linear . :
Cor tones) - Linear setting (p.29) |
Color saturation:(0) — Color tone and color saturation
[Unsharp mask v] ) adjustment (p30)
Strength:(0) I
R 0 ' Sharpness adjustment (p.31)

Threshold: (1) 0 ‘

[ [Sharpﬂess '] ]
Sharpness: (1) all

Enlargement display position*

* If an image is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.93) has been set and the edit image window
(p.135) has been enlarged.

RGB Tool Palette (p.60)

| IMG_0001.CR2 =
RAW | RGB  |nR/ALO [LENS |
|Tone curve assist ( Eaj
|Tone curve adjustment
fkee (][]
255
U_ J
0 255
Brightness: { 0
Contrast: — D’ a
Hue: 0
Il Saturation: D’

Sharpness: |D'

Automatic adjustment
(tone curve assist) (p.33, p.106)

Click white balance (p.108)

Tone curve adjustment
(p.58, p.110)

Dynamic range adjustment (p.111)

Brightness and contrast
adjustment (p.107)

Hue and Saturation adjustment
(p.109)

Sharpness adjustment (p.109)

Enlargement display position*
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NR/ALO Tool Palette
(When a RAW image is selected)

mooonce M
Raw |RGE | NRIALO [LENS | :
| Auto Lighting Optimizer
0 {— Auto Lighting Optimizer (p.61)
Low Standard Strong J
[ Noise reduction o, _—— Apply noise reduction button (p.62)
[ MR Preview... Displays the [NR Preview] window
RAW
Luminance noise reduction:{1) (p62, p133) A i
T 0 2 Luminance noise reduction for

RAW images (p.62)

Chrominance noise reduction
for RAW images (p.62)

Chrominance noise reduction:(3)

a {1 20

TIFF/IPEG

Enlargement display position*

* If an image is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.93) has been set and the edit image window
(p.135) has been enlarged.

NR/ALO Tool Palette

(When a JPEG or TIFF image is selected)

IMG_000LJPG =]

Rowt | RGE | NRIALO [LENS |

| Noise reduction Apply
RAW
Dise peduckion; (3]
TIFF/IPEG
Luminance noise reduction: {0)
o [ 20

Chrominance noise reduction:{(0)

o [ 20

Apply noise reduction button (p.112)

Displays the [NR Preview] window
(p.112, p.133)

Luminance noise reduction for
JPEG and TIFF images (p.112)

Chrominance noise reduction for
JPEG and TIFF images (p.112)

Enlargement display position*
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LENS Tool Palette

1IMG_0001.CR2 =

Raw |RreE | nR/ALO | LENS

| Digital Lens Optimizer Tune...

Setting QOFF H

Lens data : Yes

Lens aberration correction Tune... H

Peripheral illumination OFF

Chromatic aberration OFF
Color blur OFF

Distortion QFF

Digital Lens Optimizer adjustment button (p.72)
Amount of Digital Lens Optimizer (p.70)

Lens data status (p.70)
Lens data Update button (p.71)

Lens aberration correction adjustment button (p.65)

Lens aberration correction (p.65)
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List of NR Preview Window Functions @62 p.112)

PRR Previcn

[Luminance noise reduction:(7)

0
Chrominance noise reduction: (8)
g ]}

NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.

Apply noise reduction
button

Enlargement display
position

Navigator window

Image type*

Luminance noise
reduction

Chrominance noise
reduction
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List of Quick Check Window Functions .16 p.18)

50% view/100% view (moiré reduction off)/full view*!

Path and file name of image

i ; MllElidee l —— ]

Rating mark display —— ‘

Full screen

Check mark display

Check mark

Clear ‘ ‘

GI2030als

Rating
EEx s )

»”

(] aF point

Image Information ]

|
- | | 5
[ Previous ] l MNext ] ‘ ‘

] |

l Rotate left ” Rotate right l

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Tools] menu and using [Quick check tool display]
in the [View settings] tab sheet. You can also move the display
position in the enlarged display by dragging the image.

*2 To return to the normal screen, press the <Esc> key.

Displays the image in full screen*?

Removes check
marks (p.18)

Check marks (p.18)

Rating (Reject)
(p.18)

Rating (p.18)
Switches between
displayed images
Displays the AF
poins (p.16)
Displays the image
information window
(p.24)

Image rotation
(90 degree
increments)
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List of Edit Image Window Functions .3 p36)

Shows/hides tool palette Shows/hides grid*4 Enlargement ratio of displayed image Displays the trimming/
Shows/hides thumbnail display area Image information (p.23) Displays the copy stamp window angle adjustment window
Switches to main window (p.126) (p.73 to p.77, p.116 to p.120, p.142) (p.38, p.113, p.137)
Image path and file name TR

D ® ® & B Batch conversion/
L A--An Rotste left Rotste right Stamp  Trimmin = SaV|ng

Angle  process

Toolbar

’ ‘RAW RGE | NR/ALD [ LENS (plOI, p102, pl43)
Brightness adjustment
1 000 Image rotation

’ ‘Whihehalanceadjusment — [E] (90 degree
’ [m) e 1| increments)
’ . T @l Syvitches petween
’: : (& Gtencr) - srowse..._] displayed images
’ 1 Tool palette

Thumbnail display area*3 ’ L NSO O : (p.130)

Contrast:(0] D
’ s Highl\ght:((ﬂ)) 0
}_— : Shadow:(ﬂ)D i}
’ Color tone:(0) s
Color saturation:(0) {}
’ [Sharpﬂass v]
’ Sharpness: (1) {
PE—
HEm) MG 0003.CR2
Information display*2 ’
‘ 5| (998, 984) : 99,118,162 RAW [ Adobe RGE CMYK High quality
Image color space*! and work ] \— Display mode*>
e simulation display (p.
color space (p.78, p.94) CMYK lation displ 94
*1 RAW images are displayed with [RAW]. *4 You can set the grid spacing with [Grid pitch] in the [Preferences]
*2 Displays the coordinates of the cursor position and the RGB values ; (p.92).
(8-bit conversion). *> The item selected in [Viewing and saving RAW images] (p.91) of the
*3 Displays images selected in the main window. The image selected [Preferences] window is displayed.

here is enlarged and displayed on the right.
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List of Convert/Save One Image Window Functions .42 oo
—
Contents at
. s veerl| B Phots - 0% > mE a Glance
Types of image —
L -
Type of image Extension e - Basic
R Recent Places - .
Exif-JPEG JPG ' Operation
Exif-TIFF 8bit TIF = S
TIFF 16bit TIF Desktop 1000306300
0 P Advanced
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG = Save destination Operation
TIFF 16bit+Exif-JPEG | .TIFL.IPG e
™ Advanced
a'l! Image Editing
Computer and Printing
File name : G-"éf | Processin
Metwork N = g L N b g
File name: IMG_D0O1 - Save a{)%elml;g]es s
Saveastpe:  |BdPEG(JPG."JPEG) -] [ Cancel |
Quality setting Editing
: - ; 3 JPEGITIFF
Resolution*1 Image quality 0 1 JPEG compression rate* Images
Output setting ' N
Output resolution 350 dpi [¥] Embed 1CC profile in image
Embeds of ICC profiles*2 (p.145) ! Reference
Resize setting R
DRESiZE
Size changing*4 - pixel Index
Lodk aspect ratio

e
00
o

*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.78, p.94) information that is set in an image is attached the image quality becomes.
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size.

Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.78,
p.94), the ICC profiles are embedded automatically. 136



List of Trimming/Angle Adjustment Window Functions (3s p.113)

Cancels all the trimming (aspect ratio) information

Full screen display/returns to normal screen

Full screen

Reverts to the condition when the image was shot

@ 1/ 1 E\Users\CANONPictures\Photoluodt 0001.CR2 ‘

| e
l Clear Reset

Aspect ratio
Free
1,50

X
04 362

numerical values if you have selected [Custom])*1

Upper left coordinates of trimmed range (you
can also enter numerical values)

H Size of trimmed range (you can also enter

T Heigl
1577 x 1051

i Ratio of trimming range (you can also enter

numerical values)

Angle of image adjusted

G m (Drag Ipar, use the mouse to click A/V¥ or enter
— numerical values to set angle)

Angle 10.10

| Copy Paste

Applies the copied trimming range to all other
images*?2
Switches between displayed images*?2

Previous Next

Show borders
Dpadty

[~ shaw Grid ‘ ‘
Grid pitch ‘ ‘

Displays borders around a trimmed range

5] Level of opacity outside a trimmed range
Shows/hides grid lines
0 (Drag bar to set distance between grid lines)
(L center onsireen Displays the trimming range in the center of the
window
oK ” Cancel

(704, 362) -» (2281, 1413) = (1577 x1051) [ 1.50]

Copies the trimmed range and applies (pastes)

Trimming range
it to another image*2
Image rotation (90-degree increments)

*2 Operates when you have selected multiple images and the trimming/
angle adjustment window is displayed.

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.
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List of Lens Aberration Correction Window Functions (s e eetion
When the list box for selecting an extender is displayed in the To correct distortion aberration of images shot with a fisheye lens,
[Lens aberration correction] window, select the extender four effects can be selected from the [Effect] list box in addition to
attached at the time of shooting from the list box. [Shot settings] normally used for distortion correction. i ot
r.ﬁ Lens aberration correction - G_OEI)LC ] M| a Glance
Basic
Operation
Enlargement display section*!
Advanced
I o~ Operation
Reverts to the condition when the Advanced
image was shot Image Editing
and Printing
Shooting distance information Processing
slider 2 (p.68) Large Numbers
| Peripheral ilumination . . . . . of Images
H Peripheral illumination correction
I | Chromatic aberration : : :
R e H Chromatic aberration correction JFFgcist/i?'PFF
)( H Corrects blue chromatic aberration Images
H Color blur correction
ek Distortion correction
Reference
Shows/hides position of
| enlargement display section Index
el ), Grid display
| 0K || Cancel |

Corrects red chromatic aberration

Enlargement display position
(Navigator display)

00

138

*2 For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to the zoom magnification.

The slider is not displayed for images shot with an EF-M lens.

*1 The area you clicked on the image (Enlargement display position) is
displayed at 200%.



List of Digital Lens Optimizer Adjustment Window Functions 69

@ When the list box for selecting an extender is displayed in the
Digital Lens Optimizer window, select the extender attached at the
time of shooting from the list box.

s Enlargement display position (Navigator display)

tl

’ =2 Shooting distance information
Fotma o . o
<o S 73 m Shooting distance information slider*? (p.73)
[¥] setting : (100) Digital Lens Optimizer adjustment (p.72)
\%. & -
] 100
[I:l Do not sharpen previews | [Do not sharpen previews] check box (p.72)
[ Save ][ Cancel ] L
|

Enlargement display section*1

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.
*2 The slider is not displayed in the Digital Lens Optimizer window for images shot with an EF-M lens.
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List of Compositing Tool Window Functions .7

[ 100% view ]
] ‘l

=

100% display (p.80)

Foreground Image

Select foreground image (p.79)

(Mc_ooo2.cr2 2 ‘|

Thumbnail display for foreground
image (p.79)

Composite Method ‘
| weighted |

Select composite method (p.80)
Use RAW compositing (p.81)

Compose in RAW Format

Weight 0.0 5 ‘l
E [

- & Weighting slider (p.80)
2]
[iad
@E%@@ Alignment controls (p.81)
¥
[ Continue } Continue compositing (p.82)
[ Save As... ]
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List of HDR Window (Adjust Image) Functions 2 o dution
—_—
i Contents at
== a Glance
¢ TonefColor A
Brightniess: (55) | Basic
: Operation
[ -
Saturation: (S0} L Adjust tone/color (p.84)
: { Advanced
Contrast:{50) Operation
(T - T ) Advanced
- ' Image Editing
Strength: (0) and Printing
A - N —
snntnriggy) W Adjust detail emphasis (p.84) Processing
I} = Large Numbers
[
s 2 Editing
JPEG/TIFF
Images
_
Reference
[ Save As... ]
IMG_0001.CR2 /IMG_0002,CR2 / IMG_0003.CR2 [ = ]

Index

]
00
o
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List of Copy Stamp Window Functions (.73t p.77,p.116 to p.120)

| 100% view H Full screen

[

Apply Dust Delete Data

|

Repair
{Light)

Repair
{Dark)

OO | @O

Select Copy Source

[|Fix Copy Source position

[Pen type

(@ Brush

[

adius

D_

R
U

[ Previous ] [

Next

Full screen display/returns to normal screen
Applies Dust Delete Data (p.73, p.116)

Types of dust to be erased (p.75, p.118)

Specifies the copy source (p.77, p.120)
Fixes the copy source position (p.77, p.120)

Types of stamps (p.77, p.120)

Sets the size of the dust erasure range (p.75,
p.118) or copy range (p.77, p.120) in a range of
510 100 (in one pixel increments) (you can also
enter a numerical value)

Restores/redoes the image

Copies the dust erasure range or copy range
and applies (pastes) it to another image

OK

J(

Cancel

]

Set to 100% view to perform stamp operation

L = —=

* QOperates when you have selected multiple images and the copy
stamp window is displayed.

Switches between displayed images*
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (.101) R
l Batch settings
. . IMG_0001.CR2 Save folder . . Contents at
Flle names Of Images to be | mg:ggg%g&i E:\Users\User\Pictures Save deSt|nat|0n a Glance
batch saved IMG_0004,CR2 —
IMG_0005.CR2 BTt
IMG_0005.CR2 .
e e (GE= = Types of image  Basic
IMG_0009.CR2 e T : N eration
_ G 001082 freae ety b Type of image Extension P
Embeds ICC profiles*2 (p.145) IME_0012.002 Output setting | Exif-JPEG IPG
IMG:DD 14.CR2 Cutput resolution 350 dpi Embed ICC profile - -
Resolution*1 =S p— ' < EXIFTIFF Shit il éd\elz?gt(i:gﬁ
ElReser TIFF 16bit TIF "
Size changing*4 Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG
inel
; : TIFF 16bit+Exif-JPEG | .TIF/.JPG lmgggaggﬁ?ng
- Lock aspect ratio ) and Printing
i ) . S —
(?'f"t e rame — JPEG compression rate*3
' Processing
Large Numbers
) of Images
@ Mew file name
String Sequence number File name
DPP_ 0001 Ed|t|ng
|:|Save sequence number J PEG/TI FF
Ex.: DPP_0001.JPG, DPP_0002.JPG. .. Im ag es

\_

p
Image transfer settings

Open image using software

Batch transfer to other image editing
software (p.102)

Images to be converted are

Convert RAW images only

limited to RAW images*>

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.78, p.94) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.78,
p.94), the ICC profiles are embedded automatically.

Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.

*> Appears when you click the [Batch process] button (p.126, p.135)
without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.

Reference

- |
Q0
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List of Rename Window Functions .103) _
Introduction
N —
[EEEre e [
File name Extension ‘ . Contents at
[ DFPP + Shooting Date,Time » Sequence number - Sets the new flle name a Glance
Basic Settings (* Format settings ) —
Sort Sequence number
Order |n Wh'ch |mages are Sorted (@) Fit to main window 0001 []|Save sequence number Basic
FSTenE Shooting Date/Time Operatl on
() Shooting Date/Time [Y e v] ) i
Checkmark v th — - Sets the format of information —
ame file name for RAW + images . .
eckmark to apply the same - ) [vrm-00 2 in the file name
name tO RAW ImageS and JPEG ( [7] copy and Rename Browse... ) Advanced
. N Insert underbar .
images recorded simultaneously E:\Users\CANON Pictures L J Operation
H N —
Checkmark to copy the images . e
. QOriginal File Name Modified File Name
Click the [BI’O\.NSGI] button and set IMG_0001.CR2 P DPP_06-09-13_0001.CR2 P Advanced
the save destination IMG_DODL PG DPP_DE-03-12 0001 PG Image Editing
IMG_0002.CR2 DPP_06-09-13_0002.CR2 d Pr | nti n
IMG_0002.JPG DPP_06-09-13_0002.JPG an g
—
IMG_0003.CR2 DPP_06-09-13_0003.CR2
IMG_0003. PG * DPP_06-09-13_0003.1PG
IMG_0004.CR2 DPP_06-09-12_0004.CR2 Pro cess i n g
IMG_0004. PG DPP_06-09-12_0004. PG
Large Numbers
- - of Images
4 3 4 3 e e
[ Execute ] [ Cancel .
Editing
JPEG/TIFF
Images
_
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* *RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that printimages each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

|ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of 'Qna(?%ﬁgt'ith"gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y . .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. Editing
Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between I/
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. o : ndex
which are similar before and after conversion,
X but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
—— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 22 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K(D65) cases where the overall tone of an image
- ColorMatch RGB 1.8 5000K(D50) c_ha_nges somew_hat as colors which are not
______ Wide Gamut RGB 22 5000K(D50) similar and highlights change. 146
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A

AJUSE JPEG IMAGES......eiiiieiiiiiiiiieieeee et 105

AdJUSt RAW IMAQJES... oo i e eeieeeiiiiiis e et e e e e e s e e e e e e eeannenes 25

AJUSE TIFF IMAGES......eiiiiiieiiiiiiiee e 105

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt)........ccceeeeeeeieeeeeeeenn, 106
2T gTo ] 11 ToTT S 107
Click White BalanCe ............uuuvviiiiiiiiiiiiiiieeiieeeeseeeeeeseeeseeseeeeseeeees 108
LO00] 0] [ 1= 1] SRR 107
DyNamiC RANQE........uuuuiiiiie it 111
HUB e 109
RGB TOOIl Palette ........oiveieeiiieeiicie e 130
S T= LLE ] =1 1o o 109
S =T 0] LTSS 109
Tone Curve AdjUSIMENT... ... 110

Adjusting (RAW image)
APPIY AdIUSIMENTS.....cceiiiii e 99
Automatic Adjustment (Tone Curve ASSISt)......cccceeevvieerreeeeniiinnnn. 33
BIIgNINESS .uiii e 26
Brightness of HighlightS.............ciie i 57
Brightness of ShadOWS.............ooviiiiiiiiiiiiiieee e 57
Click White BalanCe ............uuuuuuuuumniiiiiiiiiiiiiiiiiieniiiieenneeneenneennnennnes 28
COolOr SAUIAtION .uvvieiiiie e e eeeee e 30
COlOr TEMPEIALUIE ....eeeiiieiiiiiiieee e 56
COl0r TONE ... e 30
LO70] (o gAY =T PP 56
L0000 = 1] PPN 29
COPY AJUSTMENTS .....uuuiiiiiiiiiiiiiiiiiiirrrirrerrrrresrrrrreerrrerr————————————. 99
DYyNamiC RANQE........uuuiiiiie et e e 57
Filter EffECt ... 31
MONOCRIOME ... e 30
Personal White BalanCe .............coceeiiiiiiiiiiiiiicee e 100
PiICTUIE STYIE . 26
Picture Style File .......ooooiiiiiii e 59
RNV oo B =1 1= 1 (= 130
SAVE AQJUSIMENLS ....vvviiiiiiiiiiiiiiiiriiiiirieiriaeveeereeereesrsesrereesesresreeeeees 99
Tone Curve AdjUSIMENT......ccooiiei e 58
B0 ] T I =1 (= o PP 31
TOOI Palette ..o 130, 131
WHhite BalanCe .........coovviiiiiii e 28

Adjustment Contents (RECIPE).....cceevviiiiriiiiiiieeiieiiiiiee e 98, 145
AdODE RGB ... 146
APPIE RGBi....ee s 146
F N = U aTo TN [ = To T 20, 21
AUto Lighting OPtIMIZEN .....oooiiiiiiieee e 61
Automatic Adjustment (Tone Curve ASSISt) ....ccooeevvvviiiiiiicinee e, 33, 106
Automatic Dust Erasure Processing.......cccccveeveveevveeennnn. 73, 75,116, 117
B
Batch Apply White Balance to Images (Personal White Balance)..... 100
Batch Change the File Name of Images.........cccccceviiiiiiiiiiieeeennee 103
Batch Convert/Save Images (Batch Process) ........ccccccvveeeiieeeeeveennnns 101
Batch Process (Batch Save JPEG and TIFF Images)............... 101, 143
Batch Process of Multiple Images
Change File NamMe ........ccooiiiiiiiiii e 103
Convert/Save (Batch Process)........ccccoucuvvveeieeeiiiiiiiiiieeeennn 101, 143
Personal White Balance..........ccccccccvviviiiii 100
RECIPE DAL .....cuvvieiiiieiiieiiie e 98
THANSTEI .. 102
Batch Settings WIiNdoW.........ccccooveiiiiiiiiiiiiiees 101, 102, 143
Batch Transfer IMages ... 102
Batch Transfer Images to Image Editing Software.............cccvvvveeeeee. 102
Before/After Comparison DiSPIAY ........ccoviiiiiiiiiieiiiiiiieeeece e 53
DIt NUMDET ... 145
BOOKMArK ... 51
BrIgNINESS. ... 26, 107
C
Change File Name..........ccccooe i, 103
Changing the File Name of Images in the Order in the Main Window... 103
CheCK MarK .......coiieiiiiiiiiie e 18, 19, 128, 134
Chromatic Aberration CorreCtion ...........cooeeeiieiieieeeceee 65
Chrominance Noise Reduction (JPEG, TIFF Images)..............cuu.... 112
Chrominance Noise Reduction (RAW IMages) .....cccccooeevvvvvvvviininnneenn. 62
Click White BalanCe.........ocoeuniiiiiiiiiie et 28, 108
CMYK SIMUIation ... 94, 96, 146
Collection WINAOW .......covuiiiiieie et aaas 6, 36, 127
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Color BIUr COorreCtion .........ccoeviieeiieiiiee e, 65
(©70] o] 001 o T- T SRR POTPPPPPPPR 146
Color Management (Color Matching)..........ooooeeieeeiiiiiiee s 145
Color Setting of the Monitor (Profiles) .........ceevvveevveeeveeriennennn. 94, 95
Color Setting of the Printer (Profiles).......ccccvvveviveveeviviriennnee. 94, 96
L070] (0] ] oI o] =T 146
ICC Profiles ..o 145
Color Management (PreferenCes)......ccccovvveviiveeeiiiiiiie e 94
Color SAtUrALiON ......cceveeeeee e 30
Color Setting of the Monitor (Profiles).......cccccevvieieiiieiciiree. 94, 95
Color Setting of the Printer (Profiles) .........cccoccuiviiiiiiiiiiiiiieeeeeen 94, 95
L0701 [0] ST o 1> o7 = S 146
AdODE RGB ... 146
APPIE RGB ... 146
Color Space Setting for Each Image ...........ccccvvvevveveiieiieeiieeveeeeee, 78
ColorMatCh RGB .......ceiiiiiiiiiiic e 146
Default Setting of Color Space...........ccccevevvvviii i eee e, 94, 95
SRGB ... e 146
Wide Gamut RGB ... 146
Color Space Setting for EACh IMage...........cooocuviiriiieeeiiiiiiiiieeeeee e 78
Color TEMPEIAIUIE......ceeeeeieeeeeeeeeee e, 56
COlOr TONE ., 30
COlOr WRNEEI ... 56
ColorMatCh RGB........oooiiiiiie 146
Compatible Cameras with the Lens Aberration Correction Function ..... 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Compositing IMAgES .......ccovvvviiiiiiii e, 78
Contact Sheet Printing (Printing a Thumbnail List)............................. 87
CONIIAST .o, 29, 107
Convert to JPEG or TIFF Image and Save................. 42,101, 136, 143
Convert/save One Image Window ..............cccoee oo, 42,136
Copy Stamp (Image Correction) ..........coevveeeiieeieiiiiieieeeeeeeeeeeeee 77,120
Copy Stamp WINAOW ..........ceevveiriiiiiiiiiieeeeeeiiee 73,75, 116, 118, 142
Copying and Pasting (Applying) ReCIPes..........ccovvvvieeiiiiiiiiie 99
Correct Images (Copy Stamp Function) ..........ccccceeveei. 77,120
Creating @ FOIAEN .......oovece e e 50

D

Default Noise Reduction SettingsS............oovvuiiiriiieeeiiiniiiiieeee e 94
Default Setting of Color SPace ..........ccuuvviiiii i, 95
Delete IMAGES ....cooiiiiiiiie e 49
Deleting

Delete IMAGES .....eiiiiiieiiiiiee et 49

Delete the SOftWAre ............uvviviiiiiiii e 125
Deleting DPP (Uninstalling) .........ccoooeiiiiiiiiiiceee 125
Detailed Setting Printing (Printing with Shooting Information)............. 86
Digital LENS OPLIMIZEN .....uuviiiiiiiiiiiiiiiiiiniiviiiiiiireerr e eesereeeeeeeeeaee 69
Display

Before/After Comparison Display...........ccccceeevviiiii, 53

Enlarged Display (Edit WINdow) ...........ccccoveiiiiiii. 11, 129

Enlarged Display (Quick Check Window) ...............cocevvveenee. 16, 134

Shooting Information Display ........cccooveieivieiiiiiiiii e, 10, 23

Single IMage DiSPlAY .........vvvviieiiiiiiieiiieiieeieeeeeeeeeeee e e eeeees 22

Synchronize Edit WINAOW ...........ccooiiiiiiiiiiieeeieeeee e 54

Thumbnail Display (Main Window).............ccccvveeeeeeiininiinnnee. 10, 126

Thumbnail Display and Enlarged Display

(Edit Image WIiNOW)........cccuviiiiiieeeeeiiiieie e 34, 135
Distortion COrrECHION ... ..o eenennnes 65
Downloading an Image to Your COMPULES .........ccceevvviiiiiieieereeeeeiiienn. 7

Downloading Images from a Camera ..........ccccuveveeeeeiiiiiiiiieeieee e, 7

Downloading Images from a Card Reader............ccccovivvvviveeeeennns 9
Downloading IMAgeS .........uuuuuuuuiiiiiiiiiiiiiiiiiniiiiarrrrerarerrrerrerrrrrr ... 7
Downloading Images from a Camera..........ccuveveeeeniiiiiiieieee e 7
Downloading Images from a Card Reader ...........ccccvvvvvvvevivvveveneennrnnenne.
Dust Delete Data ..........ccooeeieeiiieeeieeeeeeee s
Dust Erasure Processing

Automatic Dust Erasure ProCessing ...........cccccvveeeeeeeennnnnne

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair FUNCtion) ...........ccccvvveveeeennns 75, 118
DYNamIC RANGE .....coi ittt 57,111
E
Edit ImMage WiNAOW........ccooieiiiiiiii i e e ee e 34, 135
Edit WINQOW.....on ettt 11, 129
o 1] o - Adjusting
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Enlarged Display (Edit WiNAOW) .........cooiiiiiiiiiieieeiiiiiiieeee e 11, 129
Enlarged Display (Quick Check WIiNdOW) ..........ccevvvveeveieiieeiierieeeneenn, 134
1@ STV 111 7RSSR 7
EXItING DPP ... — i ran s 14
F
(=LY @] (o] gl o y=To [1 o 1 o] o SR 91
1= g = =T o 31
[0 [0 L G AV A o Lo [0 )1V T 6, 126
G
General Settings (Preferences) ......vvvcevii i 91
H
HDR (High Dynamic Range) IMagesS...........uuuvveeveeveeeeeeeeeeereeeeeeeeeeeeen 82
H I e Cover
Highlight Area Warning Indicator ..............c..uuvvviiiiiiiiieiiiieiiireeeeeeeeeeneeee. 55
HUB ettt e e et a e e e e 109
I
ICC PrOfilES ... e ittt e e e e eeeeeas 145
Image Frame Information (Image Marks) .......ccccccoovviviiiiieeennnnniiinnnn. 128
Image Marks (Image Frame Information) ...........ccccccvveeeniieeeereeenvnnnnn, 128
Image Quality
Default Noise Reduction SettingS.........cccvvvevviiiinii e i, 94
False Color REdUCHION ...........uiiiiiiiiiiiiiiiieiieeeeeeeeeeeee e 91
Improve the Quality of an Image (Main Window) ............ccc.vvueeen. 23

Noise Reduction of a JPEG Image (Luminance, Chrominance) ... 112
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save a RAW Image ... 90, 91
Image Shooting Information Display .............eeevveeeiiiiiiiiiiiiieeeees 10, 23
Improve the Quality of an Image (Main Window)..........c..cceevveevvvnnnnnn. 23
J
N | o T [ 41= (o [T PP PP PP PP PP PPPPPPPPPT 145
L
Lens Aberration COITECLION ... civu e e ee 63
Lens Aberration Correction Window ...........coouvevieiiiiieeeieeiieeeeeen, 65, 138
LENS TOOI PAIBE ....cceeiiieeeee e 132

] [T | TP UUPPUPTPPTTTR 29
Loading and Pasting (Applying) RECIPES.........uuuvvrivieereeriieeieeeeeeeeeeeeenn 99
Luminance Noise Reduction (JPEG, TIFF Images) ........cccccvveeeeeeee. 112
Luminance Noise Reduction (RAW IMages) ...........uuvvveerreereeeeeeeeeeeennn. 62
M
MAIN WINUOW ..ceiiiiieeeeeee et et e et e e et e e eaaes 10, 126
Manual Dust Erasure (Repair FUNCtion) ..........ccovvvvviiinieeeneeeennns 75,118
MAP ULHITY . 85
MONOCNIOME . ...ttt eeeeeees 30
Filter EffECt . e 31
Toning EffeCt......cooo s 31
MoVE Or COPY FOIEIS .....ooeieiiiiiieieee e 51
Y LoV o T @] o) VA [ = o 1= 50
N
Noise Reduction (JPEG or TIFF IMage).......cccccceeviiiiiiiiieiieeeeeiiieeee, 112
Noise Reduction (RAW IMaQE) ......uuurruuuriiiiiieiiiiieieeieeieeeeeeeeeeeeeeeeeeeeeeas 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ....... 112
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WINAOW.........coooiiiiiiiiieeeeeeiiieieee e 62, 112, 133
NR/ALO TOOI Palette ... ..o 131
@)
Organize IMAgES .....cooiieeeeeee s 49
Organizing IMageS ......cooeeieei e e 49
Create @ FOIAEN .......uuiiiiiiiiiiiiieiiiti ittt eee e 50
Delete IMages. ..o 49
Move or CopY FOIAErS.......coiiii i 51
MoVe OF COPY IMAGES ....uuiii i 50
Register Folders as Bookmarks...........ccccceeviiiiiiiieeiee e 51
P
Peripheral lllumination COrreCtion .............cccuvveieieeeniiniiiiiieeeee e 65
Personal White BalanCe ............ccccuuiiiiiiiiiiiiiiiiiiiiiiiiiiieeieeeveeeeeeeeeeee 100
PICTUIE STYIE e 26
Picture Style File........ccooireeeee e 59
PreferenCeS . ..o 90
(7o) (o]l \V = TaF=To [=] 0 1= o | A 94

R

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

00
©

149



General SetliNgS. ... ... 91
TOOI Palette ... 93
VIBW SEEINGS ..eteeiiiiee ittt 92
Printing
Printing a Thumbnail List (Contact Sheet Printing) ...................... 87
Printing One Sheet of Paper .......ccccoevveeviviieiiiiiie e, 14, 49
Printing Using Easy-PhotoPriNt ... 46
Printing Using Easy-PhotoPrint EX ..........cccceviiiiiiiniiinniinc, 43
Printing with a High-End Canon Printer............ccccvvvivveeeiiiiiinnnen. 88
Printing with a Large-Format Canon Printer............cccccceeeeininnee. 920
Printing with a Printer other than Canon Printers...............cc...... 49
Printing with Canon Inkjet Printers .........ccccccovvviiiiinieeeeenee 43, 46
Printing with Easy-PhotoPrint Pro .........ccccccccvvvi 88
Printing with Print Studio Pro.........cccccccii 89
Printing with Shooting Information (Detailed Setting Printing)...... 86
Rendering Intents when Using Easy-PhotoPrint .................... 94, 96
Printing a Thumbnail List (Contact Sheet Printing) ............ccoevvvvvvvnnnnn. 87
Printing One Sheet of Paper...........cvviiiiiiiiiiiiieiiieeeee e 14, 49
Printing Using Easy-PhotoPrint............cccoiieiiii e, 46
Printing Using Easy-PhotoPrint EX.........ccccovviiiiiiiiiiieeiieeee 43
Printing with a High-End Canon Printer ...........ccccvvviiiiiiineeee e, 88
Printing with a Large-Format Canon Printer ...........cccccccveviniiiiiiiienenn. 90
Printing with a Printer other than Canon Printers............cccceevvvvvvvnnnnnn. 49
Printing with Canon Inkjet Printers...........ccccoeeeeiiiiiieieee e 43, 46
Printing with Easy-PhotoPrint Pro..........cccccovvviieiiiiiiiie e, 88
Printing with Print STUAIO Pro ..o 89
Printing with Shooting Information (Detailed Setting Printing) ............ 86
Q
QUICK CheCK WINAOW.......uoiiiiiiiiiieiiiiiee e 16, 134
R
RATING . e 18, 19, 134
RAW IMa0E. et e e aees 145
VLY oo I = = £ (= P 130
Re-Adjusting @n IMage ..........uuuvvvvuiiriiiiiiiiiiiiirirreeierereerrerrrreeee.. 43,122
RECIPE . 98, 145
RECIPE FlE i 98
Re-Editing an IMage .........cooooiieeeeeeeeeeeeeeeeeeees 43,122

Registering Folders as BoOKmMarks............ccccvvvviiiiiiiiiiiiiiee e 51
Rename WINAOW ...........ueviiiiiiiiiiiiiiiieeee e 103, 144
Rendering Intent (Matching Method) ............ccccoooiiiiiiiiiee 146
Rendering Intents when Using Easy-PhotoPrint.................... 94, 96
Rendering Intents when Using Easy-PhotoPrint ...............ccccvvve. 94, 96
Repair (Manual DUSt Erasure)..............eeeeeeeeeeemmeeiieeiieeeeeeeeeeeeeenee. 75, 118
RGB T0OOl PalELte........uueiiieiiiiiiiiiiiieee e 130
Rotate Images .......coovvveiieiiiiiieee e 10, 25, 126, 127, 134, 135
S
SAUrALION .o 109
Save
Batch Convert/Save Images (Batch Process).................... 101, 143
Convert to JPEG or TIFF Images and Save ...........ccccevvevenn. 42,136
SOV .. 41, 121
SAVE AS ..o 41,121
Save JPEG or TIFF Image as a Separate Image ....................... 121
View and Save RAW IMagesS..........ouviiiiiiiiiiiiiiiieeee e 91
SV E A it 41,121
SaVINg RECIPES.....cco e, 99
SeleCt IMAgES....ccoe i, 10, 16, 34
Shadow Area Warning INdiCator...........ccooeeeiiiiieiiiiciccccees 55
SNAIPNESS ... 31, 109
Shooting Information Display...........ccceeiiiieiiiiiieiiin e, 10, 23
SNOMCUL KBYS ... Cover
Single IMage DiSPlay .........ciii i e 22
Single Image Display of RAW and JPEG Image...........cccccvveeeviinnnen 22
Sorting Images
(O g T<Tod Q1 1 F= 1 18, 19
RAINGS ..oiieiiieeiieeeeee e 18, 19
SRGB ...t 146
Starting UP DPP ... 6
SUPPOEd IMAGES ... 3
Synchronization (Edit WiNAOW).........oooooiiiiiiioi s 54
Synchronize Edit WINAOWS ... 54
SYNCAIONIZE IMAGES ..o 54
System ReqUINEMENTS .......coooiiiiiiiee e, 3
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T
Thumbnail Display (Main Window) ............cceeeiiiiiiiiieieeeene 10, 126
Change the Display ........ccoovvieiiiiiiiiii e 10
Thumbnail Display and Enlarged Display (Edit Image Window)......... 34
Thumbnail Display of Images (Main Window).............ccccceeeeeeeeeee. 10
Change the DiSPlay ...........uuueuuuiiiiiiiiiiiiiiiiiiieiieeiieeeieeeeeeeeeeeeeeeeeeeees 10
TIFF IMAGE ...t e e e eeeaees 145
TONE CUMNVE ...ttt ettt ettt et e ettt e e et e ee e e e e e eeeeeeeeeeeeees 145
Tone Curve AJUSIMENT .......ooviiiiiiiiiiie e 58, 110
Tone Curve Assist (Automatic Adjustment) ...............oooooeeee. 33, 106
TONING EffQCT. ...ttt e 31
Tool Palette
LENS TOOl Palette.......eeeiiieeiieiieeeeieeeeeeeeeeeeeeeeeeeeeeee e 132
NR/ALO TOOl Palette........ueeeeeiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeee e 131
RAW TOOI Palette.....uvuuiieeecciieeecce e 130
RGB TOOIl PAlette .....ovvviiieeeiieeeciee e 130
Tool Palette (PreferenCes) .......uuvveeiieiiiiiiieiiiiiiieeieeeeeee et 93
Transfer
Batch Transfer Images to Image Editing Software..................... 102
Transfer an Image to PhotoShOp..........oooovviiiiiiiiiiiiiiiceee s 78
Transfer an Image to Photoshop ..., 78
Trimming and Adjusting the Angle of an Image.......................... 38, 113
Trimming/Angle Adjustment Window..............cccccoeeeeeeeeen. 38, 113, 137
U
UNSNAIP MASK....ciiiiiiiiiiiiiiee ettt e e 32
\Y
View Settings (PreferenCes) ..........uuueeuuruuueieiiiiiieeiieiieeeeeeeeeeeeeeeeeeeeeeeee 92
W
WHIte BaIANCE... ... 28
Click White BalanCe .......ooviieieie e 28, 108
(7] (o g =T 0 0] 0 1=T =1 (0[P 56
COolOr WHEEL.... ..o 56
Personal White BalanCe .............coceeiiiiiiiiiiiiiicii e 100
Wide GamMUE RGB ......coooi e 146
WOTK COlOr SPACE.... oot e e e e e 78

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
All other trademarks are the property of their respective owners.
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